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          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to
       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[REPORT OF ACTION TAKEN IN CLOSED SESSION
TUESDAY, AUGUST 19, 2014 ON PAGE 89]
SUP. KNABE, CHAIRMAN: I ASK EVERYONE TO PLEASE RISE. THIS MORNING WE WILL BE LED IN OUR INVOCATION BY THE REVEREND MARK NAKAGAWA FROM CENTENARY UNITED METHODIST CHURCH IN LOS ANGELES. THE PLEDGE OF ALLEGIANCE WILL BE LED BY BECKY FREEMAN, FORMER AIRMAN, UNITED STATES AIR FORCE. REVEREND NAKAGAWA. 

REV. MARK NAKAGAWA: THANK YOU, SUPERVISOR KNABE. BEFORE I OFFER THE INVOCATION, I NEED TO SAY A FEW WORDS TO PREFACE IT. FIRST OF ALL IT IS GOOD TO BE BACK IN THESE CHAMBERS, I WAS HERE THREE YEARS AGO FOR AS PRESIDENT FOR THE NISEI WEEK FESTIVAL WHICH JUST CONCLUDED. I WANTED TO THANK THIS BOARD FOR WHAT IT DOES TO MAKE SURE THE NISEI WEEK FESTIVAL HAPPENS EVERY YEAR AS WELL AS THE TANABATA FESTIVAL. WE JUST CONCLUDED ANOTHER SUCCESSFUL FESTIVAL. SO THANK YOU, BOARD OF SUPERVISORS. I ALSO WANT TO THANK PERSONALLY COUNCILMEMBER I'M SORRY COUNTY BOARD OF SUPERVISORS MEMBER KNABE. HE DOESN'T KNOW IT BUT HE HAS BEEN A BIG HELP TO THE UNITED METHODIST CHURCH. I'M ON THE BOARD OF BAKER HOMES IN HACIENDA HEIGHTS WHICH IS A RETIREMENT HOME FOR METHODIST MINISTERS. WE'VE HAD TO CALL ON HIS OFFICE OUT THERE TO HELP MITIGATE SOME ISSUES. SO THANK YOU. 

SUP. KNABE, CHAIRMAN: ALL DONE WITH A LOT OF PRAYER FOR THOSE RETIRED MINISTERS. 

REV. MARK NAKAGAWA: OKAY THANK YOU. AND THEN FINALLY I'D LIKE TO ACKNOWLEDGE TWO COLLEAGUES WHO ARE HERE TODAY. REVEREND DAN LEWISH WHO IS A NEWLY APPOINTED PASTOR OF FIRST UNITED METHODIST CHURCH HERE IN DOWNTOWN LOS ANGELES AND ALSO WITH HIM IS REVEREND (INAUDIBLE) WHO IS REPRESENTING OUR BISHOP. THE REVEREND WAS THE LEADER OF OUR HISPANIC MINISTRIES HERE IN THIS CONFERENCE. LET US BE IN AN ATTITUDE OF PRAYER AT THIS TIME. OUR HEAVENLY CREATOR, THROUGHOUT HISTORY YOU HAVE REVEALED YOURSELF IN MANY DIFFERENT WAYS. AS YAHWEH, ALLAH, BUDDHA AND AS CHRIST. THROUGH YOUR MANY REVELATIONS, YOU HAVE CALLED US TO BE YOUR PEOPLE, WHO UPHOLD JUSTICE, SHOW MERCY, DELIVER KINDNESS AND COMPASSION. WE GIVE YOU THANKS FOR THE LEADERSHIP OF OUR COUNTY EXPRESSED HERE THROUGH THESE ELECTED AND APPOINTED LEADERS, WE PRAISE YOU FOR THE WORK THAT THEY CONTINUE TO DO TO MAKE SURE THAT OUR COUNTY IS A HAVEN AND HOME AND REFUGE FOR ALL WHO SEEK PEACE AND TRANQUILITY IN THEIR LIVES. ESPECIALLY IN THESE TUMULTUOUS TIMES, THE CHALLENGES THAT THE WORLD PRESENTS THEM, AND US, ARE VERY GREAT. AND SO WE ASK YOU, OUR HEAVENLY CREATOR, TO CONTINUE GUIDING THIS COUNTY BOARD OF SUPERVISORS WITH YOUR DIVINE AND INFINITE WISDOM, GIVING THEM THE VISION TO SEE CLEARLY, THE COURAGE TO ACT BOLDLY AND THE INSPIRATION TO DO JUSTLY. WE GIVE YOU THANKS AGAIN AND PRAISE YOU THROUGH THE MANY WAYS IN WHICH WE WORSHIP AND ACKNOWLEDGE YOU, AMEN. 

BECKY FREEMAN: PLEASE FACE THE FLAG AND PLACE YOUR RIGHT HAND OVER YOUR HEART AND FOLLOW ME IN SAYING THE PLEDGE OF ALLEGIANCE. [PLEDGE OF ALLEGIANCE RECITED.] 

SUP. KNABE, CHAIRMAN: IT'S MY PRIVILEGE AND HONOR ON BEHALF OF SUPERVISOR MOLINA TO WELCOME REVEREND MARK NAKAGAWA WHO SERVES AS WE MENTIONED EARLIER THE SENIOR MINISTER OF CENTENARY UNITED METHODIST CHURCH HERE IN LOS ANGELES. AFTER EARNING HIS DEGREES FROM THE U.C.L.A. AND PACIFIC SCHOOL OF RELIGION, HE HAS DEVOTED HIS LIFE TO COMMUNITY MINISTRIES. IN ADDITION TO HIS LEADERSHIP AT HIS CHURCH, HE DEVOTES HIS TIME AND TALENTS TO THE ASIAN AMERICAN LANGUAGE MINISTRY TASKFORCE, THE NATIONAL JAPANESE AMERICAN UNITED METHODIST CAUCUS AND THE CALIFORNIA PACIFIC ANNUAL CONFERENCE FOUNDATION. HE'S ALSO ACTIVE IN MANY WORTHY CIVIC ORGANIZATIONS SUCH AS NISEI WEEK FOUNDATION, LITTLE TOKYO COMMUNITY COUNCIL AND THE CHRISTIAN MUSLIM CONSULTING GROUP OF SOUTHERN CALIFORNIA. SO WE WANT TO THANK REVEREND FOR TAKING TIME OUT OF HIS BUSY SCHEDULE TO JOIN US AND TO LEAD US IN A WONDERFUL INVOCATION. 

SUP. ANTONOVICH: I ALSO HAVE THAT THE PASTOR WAS ALSO FORMER CHAIRMAIN OF THE NISEI WEEK AND QUITE INVOLVED IN THE COMMUNITY AND IN THE PARADE AWEEK AGO SUNDAY. SO THANK YOU FOR YOUR LEADERSHIP, PASTOR. TODAY WE WERE LED IN THE PLEDGE OF ALLEGIANCE BY BECKY FREEMAN FROM THE ANTELOPE VALLEY WHO SERVED IN THE UNITED STATES AIR FORCE BETWEEN 1971 AND '79. SHE'S A GRADUATE INDIANA UNIVERSITY. WE THANK HER FOR COMING DOWN AND LEADING US IN THE PLEDGE. [APPLAUSE.] 

SUP. KNABE, CHAIRMAN: ALL RIGHT MADAM EXECUTIVE OFFICER. WE WILL BEGIN WITH THE AGENDA. 

SACHI HAMAI, EXEC. OFFICER: THANK YOU, GOOD MORNING, MR. CHAIRMAN, MEMBERS OF THE BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 3, PRESENTATION AND SET MATTERS. ON ITEM S-2 AS INDICATED ON THE POSTED AGENDA AT THE MEETING -- EXCUSE ME. LET ME BACK UP. ON ITEM S-2, AS INDICATED ON THE POSTED AGENDA, THE INSPECTOR GENERAL REQUESTS THAT THIS ITEM BE CONTINUED TO SEPTEMBER 23, 2014. ON ITEM S-3, ALSO AS INDICATED ON THE POSTED AGENDA, AT THE MEETING OF AUGUST 12, 2014, THIS ITEM WAS CONTINUED TO SEPTEMBER 16, 2014. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: ON PAGE 4, AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEMS 1-D AND 2-D. ON THESE ITEMS, THERE'S A REQUEST FROM EITHER A MEMBER OR MEMBERS OF THE PUBLIC TO HOLD THEM. ON PAGE 5, AGENDA FOR THE MEETING OF THE REGIONAL PARK AND OPEN SPACE DISTRICT, ITEM 1-P, THAT ITEM IS BEFORE YOU. 

SUP. KNABE, CHAIRMAN: MOVED BY SUPERVISOR YAROSLAVSKY. THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO BE THE ORDER. 

SACHI HAMAI, EXEC. OFFICER: ON PAGE 6, BOARD OF SUPERVISORS, ITEMS 1 THROUGH 9. ON ITEM NO. 1, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 5, THERE'S ALSO A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 6, SUPERVISOR ANTONOVICH REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO SEPTEMBER 2, 2014. THE REMAINING ITEMS UNDER THE BOARD OF SUPERVISORS ARE BEFORE YOU. 

SUP. KNABE, CHAIRMAN: ON THE REMAINDER, MOVED BY SUPERVISOR ANTONOVICH. THE CHAIR WILL SECOND. WITHOUT OBJECTION SO BE THE ORDER. 

SACHI HAMAI, EXEC. OFFICER: PAGE 9, CONSENT CALENDAR, ITEMS 10 THROUGH 39. ON ITEM NUMBER 11, THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 14 AND 15, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THESE ITEMS. ON ITEM NO. 17, THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 19, 20, 21 AND 22, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THESE ITEMS. ON ITEM NO. 26 AND 27, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THESE ITEMS. ON ALSO ON ITEM NO. 29 AND 30, THERE'S A REQUEST FROM A MEMBER. PUBLIC TO HOLD THESE ITEMS. ON ITEM NO. 31, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED TO SEPTEMBER 9, 2014. 

SUP. KNABE, CHAIRMAN: SO ORDERED. 

SACHI HAMAI, EXEC. OFFICER: AND THE REMAINING ITEMS UNDER THE CONSENT CALENDAR ARE BEFORE YOU. 

SUP. KNABE, CHAIRMAN: ON THE REMAINING, MOVED BY SUPERVISOR YAROSLAVSKY. SECONDED BY SUPERVISOR RIDLEY-THOMAS. WITHOUT OBJECTION, SO BE THE ORDER. 

SACHI HAMAI, EXEC. OFFICER: ON PAGE 20, DISCUSSION ITEMS, ITEMS 40 THROUGH 41. ON ITEM NO. 40 AS INDICATED ON THE POSTED AGENDA, WE WILL HOLD THIS ITEM FOR A REPORT BACK FROM THE DIRECTOR OF PUBLIC SOCIAL SERVICES WHICH WAS REQUESTED ON JULY 1, 2014. ON ITEM NO. 41, WE WILL ALSO HOLD THIS FOR A REPORT. ON PAGE 21, MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE SUPPLEMENTAL AGENDA. ON ITEM NO. 42-A THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 42-B, SUPERVISOR RIDLEY-THOMAS ABSTAINS FROM THE VOTE. AND ALSO ON THIS ITEM, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD IT. AND THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NO. 1. SUPERVISOR RIDLEY-THOMAS? SUPERVISOR YAROSLAVSKY? SUPERVISOR KNABE? I'D LIKE TO CALL UP THE MEMBERS OF THE MARTIN LUTHER KING MACC DREAM TEAM WHO ARE L.A. COUNTY SUPER STARS IN SERVICE EXCELLENCE IN ORGANIZATIONAL EFFECTIVENESS. THE M.L.K. DREAM TEAM THEY RECEIVED THEIR SCROLLS EARLIER. THEY EMBRACE THE CONCEPTS ASSOCIATED WITH PATIENT-CENTERED SCHEDULING COLLABORATIVE AND CAPITALIZED ON THE CENTER'S MEDICAL HOME CONCEPT OF TEAM-DIRECTED PATIENT CARE. ACCESSIBILITY, ACCOUNTABILITY AND CUSTOMER SERVICE WAS THE FOCUS OF THE TEAM. AND EACH MEMBER OF THIS TEAM BROUGHT WITH THEM A VERY UNIQUE PERSPECTIVE WHICH ALLOWED THEM TO ACHIEVE THREE GOALS: THE TEAM WORKED TOGETHER TO COMPLETE AND RECONFIGURE THE PROCESS FOR PATIENT SCHEDULING AND APPOINTMENT PREFERENCES IN THE INTERNAL MEDICINE PRACTICE. BY INCORPORATING A PATIENT FIRST MENTALITY THE TEAM DEDICATED A SINGLE LINE FOR PATIENTS CALLING TO SPEAK WITH A CLINICIAN OR TO INQUIRE ABOUT UPCOMING EMPLOYMENTS. ALSO CAME UP WITH THE ENHANCED SCRIPT FOR APPOINTMENT CONFIRMATION CALLS AND DEVELOPED A RIGOROUS ALGORITHM TO HELP THEM DETERMINE WHICH PATIENTS WERE MOST LIKELY TO KEEP THEIR APPOINTMENTS AND WHICH WERE LIKELY TO CANCEL WITHOUT CALLING. AS A RESULT, THEY WERE ABLE TO REDUCE THE NO-SHOW RATE FROM 26 PERCENT TO LESS THAN 10. THIS TEAM PRIORITIZED PATIENT PREFERENCES FOR APPOINTMENT TIMES AND WERE EVEN ABLE TO PROVIDE SAME-DAY ACCESS. THEY MONITORED THE THIRD NEXT AVAILABLE APPOINTMENTS, AN INDUSTRY STANDARD MARKER THAT MEANS PATIENTS CAN RELIABLY GET AN APPOINTMENT WITHIN TWO WEEKS AND HAVE BEEN ABLE TO REMAIN CONSISTENTLY BELOW THE 14 DAYS FOR APPOINTMENT SCHEDULING. SO EACH MEMBER, AS I SAID, RECEIVED THEIR SCROLL EARLIER. EACH MEMBER WAS ALIGNED IN PURPOSE AND MISSION. AND AS A RESULT, YOU CAN SEE THAT THEIR MISSION WAS ACHIEVED. SO WE WANT TO ASK YOU TO JOIN US IN CONGRATULATING THE MARTIN LUTHER KING MACC INTERNAL MEDICINE DREAM TEAM FOR THEIR OUTSTANDING WORK. [APPLAUSE.] 

SPEAKER: WE'RE GRATEFUL AND HONORED TO BE RECOGNIZED IN THIS WAY. I THINK WHAT'S REALLY SPECIAL ABOUT THIS PARTICULAR PROJECT IS THAT IN ADDITION TO JUST MEETING OUR GOALS OR GETTING A NUMBER DOWN LIKE A NO-SHOW RATE DOWN, WHAT THIS PROJECT REALLY HELPED US DO WAS TO MEET THE D.H.S. SERVICE MISSION FOR ACCESS FOR OUR PATIENTS. FOR EVERY PATIENT THAT KEEPS AN APPOINTMENT, THAT'S A PHYSICIAN SLOT THAT WAS UTILIZED FOR PURPOSE TO IMPROVE THE HEALTH OF THAT PATIENT. ANY SLOT THAT GOES UNUSED OR WASTED FOR A NO-SHOW CAUSES OTHER DELAYS IN THE DAY IS A MISSED OPPORTUNITY. AND I ALWAYS LIKE TO SAY CHANGE MAINTENANCE IS HARDER THAN CHANGE. AND I'M REALLY PROUD TO SAY THAT WE SUBMITTED THIS PROJECT ABOUT A YEAR AGO FOR THE L.A. COUNTY STARZ AND NOW A YEAR LATER WE'RE STILL CONSISTENTLY MEETING OUR GOALS FOR IMPROVED ACCESS FOR OUR PATIENTS. SO THANK YOU VERY MUCH. 

SUP. KNABE, CHAIRMAN: THANK YOU. CONGRATULATIONS. CONGRATULATIONS, EVERYBODY. EVERYBODY. DREAM TEAM. NEXT WE HAVE OUR ANNUAL AWARDEES. WE'D LIKE TO CALL UP THE FOLLOWING FROM THE SYBIL BRAND COMMISSION SCHOLARSHIP AWARDEES. AT THIS TIME WE'D LIKE TO CALL UP THE FOLLOWING FROM THE SYBIL BRAND COMMISSION CHAIRPERSON ELEANOR MONTANEAU. VICE CHAIR FRANK BASIO. COMMISSIONERS DONALD ANDREWS, CHERYL GRILLS, SUSAN BURTON, BARBARA RIGBY AND ANNE GILL. JOINING THEM ARE THE 2014 SYBIL BRAND SCHOLARSHIP AWARDEES. ALICIA RODRIGUEZ, IRMA MUNOZ AND QURON CLARK, CHRISTIAN MORAN IS ALSO A RECIPIENT BUT HE'S NOT ABLE TO BE WITH US TODAY. THE SYBIL BRAND COMMISSION FOR INSTITUTIONAL INSPECTIONS FORMERLY KNOWN STRICTLY AS THE INSTITUTIONAL INSPECTION COMMISSION, WAS ESTABLISHED BY THIS BOARD BACK IN 1959 WITH ITS MISSION TO ENHANCE THE QUALITY OF LIVES FOR THOSE INCARCERATED AND OR LIVING UNDER VERY STRICT SUPERVISION OR ASSIGNED TO A GROUP HOME ENVIRONMENT. TO THIS END THE COMMISSION ESTABLISHED A SCHOLARSHIP PROGRAM IN 2007 TO ASSIST HIGH SCHOOL GRADUATES WHO ASPIRE TO PURSUE A HIGHER EDUCATION IN COLLEGIATE CLASSROOMS. THE COMMISSION HAS SINCE AWARDED OVER 20 SCHOLARSHIPS TO DESERVING YOUNG MEN AND WOMEN WHO HAVE DEMONSTRATED NOTEWORTHY EDUCATIONAL AND PERSONAL ACHIEVEMENTS. THIS YEAR, THE COMMISSION IS AWARDING $300 EACH TO ALL 2014 RECIPIENTS AND SO IT'S MY PLEASURE TO PRESENT A SCROLL HONORING EACH OF THESE FOUR EXCEPTIONAL STUDENTS. FIRST UP IS ALICIA RODRIGUEZ. ALICIA GRADUATED FROM BELL GARDENS IN JUNE WITH A 3.12 G.P.A. SHE'S GOING TO BE ATTENDING CAL STATE DOMINGUEZ HILLS AND THEN PLANS TO PURSUE A MAJOR IN PEDIATRIC ONCOLOGY AT U.C.L.A. CONGRATULATIONS. [APPLAUSE.] YOU RECOGNIZE ON THE FIRST SCROLL WE PRESENTED HAS SYBIL'S PICTURE ON IT, TOO. THAT'S VERY SPECIAL. AS I MENTIONED CHRISTIAN MORAN GRADUATED FROM BISHOP LEMONT FROM 3.5. HE WILL BE ATTENDING THE COLLEGE OF ST. BENEDICT, ST. JOHN'S UNIVERSITY TO PURSUE A CAREER IN PSYCHOLOGY. AND HAS A GOAL OF BECOMING A SWAT TEAM MEMBER. BUT HE WAS UNABLE TO JOIN US TODAY. OUR THIRD RECIPIENT IS IRMA MUNOZ. IRMA GRADUATED FROM JAMES A. GARFIELD HIGH SCHOOL THIS PAST JUNE AND HAS BEEN ACCEPTED TO CHAPMAN UNIVERSITY AND PURSUE A MAJOR IN SOCIAL WORK, CONGRATULATIONS, IRMA. OUR FINAL RECIPIENT IS QURON CLARKS. HE GRADUATED FROM LOS ANGELES HIGH SCHOOL FOR THE ARTS THIS LAST JUNE WITH A 3.0. HAS BEEN INVITED TO -- WOW. DUDE, YOU'RE GOING A LONG WAYS. HE'S BEEN INVITED TO ATTEND THE INSTITUTE FOR ARTS IN BARCELONA, SPAIN. CONGRATULATIONS. THAT'S REALLY EXCITING. PRETTY COOL. WE'D LIKE TO EXTEND A HEARTFELT THANK YOU TO ALL OF THESE STUDENTS AND TO THE COMMISSION AND PARTICULARLY THE YOUNG PEOPLE WHO NOT NOT ONLY CONTINUED TO EXCEL ACADEMICALLY BUT TO GIVE NUMEROUS HOURS IN THEIR COMMUNITIES AND TO VARIOUS PERSONAL ACHIEVEMENTS AND PERSONAL CONCERNS. SO WE WANT TO WISH YOU ALL THE BEST OF LUCK IN YOUR CONTINUING EDUCATION AND I KNOW THAT YOU'RE GOING TO HAVE AN EXTREMELY BRIGHT FUTURE. AND WE ALSO WANT TO THANK THE COMMISSION FOR THEIR DEDICATION TO THESE STUDENTS EACH AND EVERY YEAR AND THE MANY OTHER INDIVIDUALS THAT THEY HELP EACH AND EVERY DAY HERE IN THE COUNTY OF LOS ANGELES. SO LET'S GIVE THEM ALL A BIG ROUND OF APPLAUSE. CHAIRMAN, DO YOU WANT TO SAY ANYTHING? MIKE? 

SUP. ANTONOVICH: MR. CHAIR AND MEMBERS TODAY WE WILL RECOGNIZE BOB WIEGAND WHO IS HELPING THE MICHAEL HOFFMAN FOUNDATION RAISE FUNDS TO BENEFIT CHILDREN BATTLING CANCER. THEY HONOR THE MEMORY OF A 12-YEAR-OLD CHRISTOPHER WILKE WHO PASSED AWAY AFTER A BATTLE EARLIER THIS YEAR. TO HONOR THIS MEMORY OF YOUNG CHRISTOPHER AND RAISE MONEY, BOB HAS RUN 83.36 MILES. HOW MANY POUNDS DID YOU LOSE? A COUPLE POUNDS. [APPLAUSE.] HE BEGAN AT MY FAVORITE BASEBALL TEAM'S BASEBALL STADIUM. LOS ANGELES ANGELS STADIUM IN ANAHEIM WHICH WAS THE FAVORITE BASEBALL TEAM AND ENDED IN THE SANTA CLARITA VALLEY. ALONG THE WAY MEMBERS OF THE SHERIFF AND FIRE DEPARTMENT ALONG WITH COMMUNITY MEMBERS JOINED IN. SO WE WANT TO THANK YOU FOR YOUR LEADERSHIP IN BRINGING ATTENTION TO A VERY SERIOUS ISSUE. WITH US TODAY IS JOE AND MONICA WILKE, CHRISTOPHER'S GRANDPARENTS, AND GILLIAN STONE FROM THE MICHAEL HOFFMAN FOUNDATION. SO THANK YOU FOR DOING WHAT YOU ARE DOING. 

ROY WIEGAND: I'D LIKE TO THANK EVERYBODY FOR HAVING ME HERE TODAY. THERE'S A LOT ON THE AGENDA. IT WAS VERY MUCH LIKE LIVING A MOVIE ON JULY 4TH BEING ABLE TO RUN. I'M A LONG TIME RUNNER AND GETTING TO RUN FROM ANAHEIM CITY TO SANTA CLARITA AND GETTING TO PUSH KIDS IN A SPECIAL STROLLER THAT WERE BATTLING CANCER AND THEIR FAMILIES FOR SHORT DISTANCES OF THE PARTS OF THE RUN. AND CHRISTOPHER WAS A 12-YEAR-OLD BOY SCOUT. THAT'S HOW I KNEW HIM. HE WAS IN THE SAME TROOP AS MY SON. AND HE INSPIRED THIS WHOLE THING. THIS IS A KID WHO REALLY HAD A RIPPLE EFFECT ACROSS BURBANK AND OTHER PLACES. BUT TO GIVE YOU AN IDEA OF WHAT INSPIRED ME IS THERE WERE 1,400 PEOPLE AT HIS FUNERAL. FOR A 12-YEAR-OLD BOY. SO HE WAS A VERY SPECIAL KID. HE WAS ONLY THE THIRD PERSON EVER RECORDED TO HAVE THE KIND OF CANCER HE HAD, THE CANCER OF THE BILE DUCT. SO THIS WAS IN HIS MEMORY. THAT'S WHAT INSPIRED ME. IT WAS A LOT OF MILES TO COVER. BUT WHEN I STARTED GETTING TIRED, I WOULD THINK ABOUT WHAT CHRISTOPHER WENT THROUGH. AND ALL THE OTHER KIDS THAT I GOT TO MEET ALONG THE WAY THAT THE HOFFMAN FOUNDATION ULTIMATELY, THAT'S WHO WE'RE RAISING AWARENESS AND FUNDS ABOUT, HOW THEY HELP THESE KIDS AND THESE FAMILIES. AND SO I WAS THE LUCKY ONE THAT DAY. AND MAYBE I'LL GET TO DO IT AGAIN IN THE FUTURE. THANK YOU AGAIN FOR THIS. IT IS VERY SPECIAL. THANK YOU. [APPLAUSE.] 

SPEAKER: I'M JUST AMAZED AT HOW CHRISTOPHER TOUCHED SO MANY PEOPLE IN HIS SHORT 12 YEARS. LIKE WE SAID 1,400 PEOPLE WERE AT THE FUNERAL, 800 AT THE ROSARY. COUNTLESS FUNDRAISERS, HIS SCHOOL THAT HE WENT TO. THEY DID A WALK IN HIS NAME. THEY RAISED $10,000. LOCAL MEXICAN RESTAURANT HAD A FUND-RAISER. HIS BOY SCOUT TROOP HAD A FUND-RAISER. THEY RAISED BETWEEN 8,000 AND 10,000 DOLLARS ON A PANCAKE BREAKFAST WHICH IS UNHEARD OF. THEY USUALLY BRING IN 2,000, RIGHT? 2,000. AND HE NEVER COMPLAINED. AND AS ROY SAID, HE WAS ONLY THE FIRST CHILD IN THE HISTORY OF CHILDREN'S HOSPITAL, WHICH IS OVER 100 YEARS, TO HAVE BEEN DIAGNOSED WITH THIS CANCER, THE SECOND CHILD IN THE UNITED STATES, A GIRL OF 17 IN MICHIGAN. AND THEN CHRISTOPHER AT THE AGE OF 12. AND A YOUNG BOY IN JAPAN, WHO WAS 11. IT'S A DISEASE OF OLDER PEOPLE, USUALLY IN THEIR 70S. THEY CONSIDER YOUNG TO BE 50. AND SO THEY DIDN'T KNOW HOW TO TREAT CHRISTOPHER. OUR FAMILY IS PARTAKING IN A RESEARCH PROJECT THROUGH THE MAYO CLINIC TO HOPEFULLY COME UP WITH AN EARLY DIAGNOSIS BECAUSE WHEN CHRISTOPHER WAS DIAGNOSED IN JANUARY 4TH, HE WAS STAGE 4 AND HE ONLY LIVED 74 DAYS. SO WE'RE HOPING THAT THIS IS GOING TO BE PART OF HIS LEGACY, THAT AND ALL THE PEOPLE THAT HE HAS BROUGHT TOGETHER. IT'S -- I CAN'T THINK EVERYBODY ENOUGH FOR ALL THEY'VE DONE FOR OUR KIDS. THANK YOU. [APPLAUSE.] 

SUP. ANTONOVICH: TODAY WE WILL RECOGNIZE A VERY FINE GENTLEMAN FROM THE SANTA CLARITA VALLEY, DARRELL PAULK WHO IS RETIRING AS THE CHIEF EXECUTIVE OFFICER FOR THE CHILD AND FAMILY CENTER OF THE SANTA CLARITA VALLEY WHO WAS ALSO A GREAT BASEBALL FAN AND WHOSE SON PLAYS PROFESSIONAL BASEBALL FOR THE COLORADO. WE HOPE HE COMES BACK TO THE LOS ANGELES ANGELS, BUT WE'LL SEE. BETTER WEATHER. SO, ANYWAY, DARRELL HAS BEEN THE C.E.O. SINCE DECEMBER I SHOULD SAY OCTOBER OF 2008 OF THE CHILD FAMILY CENTER IN THE SANTA CLARITA VALLEY AND PRIOR TO THAT HE HAD BEEN THE C.E.O. OF THE LEROY HANES CENTER FOR CHILDREN AND FAMILIES IN LAVERNE FROM 1988 TO 2006. HE ALSO SERVES ON THE BOARDS OF THE ASSOCIATION OF PSYCHIATRIC HUMAN SERVICES AGENCIES, THE CALIFORNIA ALLIANCE OF CHILD AND FAMILY SERVICES AND THE NATIONAL ASSOCIATION OF PSYCHIATRIC TREATMENT CENTERS FOR CHILDREN. WITH HIM TODAY IS HIS WIFE PATTI AND SONS BRIAN AND MICHAEL AND DAUGHTER WHO LIVES IN TEXAS WHO COULD NOT BE HERE TODAY. SO DARRELL HAS BEEN A PLEASURE FOR MY STAFF AND I TO WORK WITH YOU. WE HOPE TO HAVE YOU CONTINUED INVOLVEMENT IN THE COMMUNITY AND HELPING OUR YOUTH. BECAUSE WITHOUT STRONG PARENTAL AND STRONG COMMUNITY SUPPORT THE CHILDREN ARE LEFT RUDDERLESS IN A VERY DANGEROUS WORLD BUT WITH THE SUPPORT THAT THE CHILD FAMILY CENTER HAS BEEN ABLE TO GIVE THESE CHILDREN AND WITH THE PARENTS, THESE CHILDREN HAVE GONE ON AND WILL GO ON TO BE THE PRODUCTIVE LEADERS OF OUR GREAT NATION. SO, DARRELL? 

DARRELL PAULK: SUPERVISOR ANTONOVICH, I WANT TO THANK YOU FOR RECOGNIZING ME TODAY AND I WANT TO THANK THE DREAM TEAM. THIS IS THE CHILD AND FAMILY CENTER DREAM TEAM THAT I HAVE HERE. NOT ONLY MY FAMILY BUT WE HAVE ONE OF OUR BOARD MEMBERS, GLORIA MCCARTLE FOR TIME REPRESENTING THE BOARD. I HAVE THE NEW C.E.O. AND I CAN'T WAIT FOR HER TO TAKE OVER, DR. JOAN ASHOFF IS HERE. AND THE REST OF THE EXECUTIVE TEAM. I WANT TO THANK THEM FOR GETTING UP AT 4:30, SOME OF THEM, TO BE HERE. MIKE, I WANT TO THANK YOU NOT ONLY AS A BOARD OF SUPERVISORS AND YOUR SUPPORT ALONG WITH YOUR COLLEAGUES, I ALSO WANT TO THANK YOU FOR BEING A FRIEND TO THE CHILD AND FAMILY CENTER. WE'RE 38 YEARS OLD THIS SUMMER. MIKE, YOU'VE BEEN SUPPORTING US FOR 38 YEARS. AND LIZ SEIPLE WHO WAS THE FOUNDER WAS MY PREDECESSOR FOR 32 YEARS, MADE IT A LOT LONGER THAN I DID, SHE HAS A LOT MORE STAMINA. 

SUP. ANTONOVICH: SHE'LL BE ON OUR CHILDREN AND FAMILY COMMISSION. 

DARRELL PAULK: SHE'S ON THE AGENDA TODAY. BUT SHE COULDN'T BE HERE. SHE IS OUT OF TOWN. SHE WANTED TO SAY HI AND THANK YOU. THANK YOU SO MUCH FOR ALL THE SUPPORT. THE CHILD AND FAMILY CENTER IS THE PRIVATE COMMUNITY HEALTH CENTER FOR ALL THE SANTA CLARITA VALLEY AND ON INTO THE SAN FERNANDO VALLEY. WE APPRECIATE YOU OF YOUR SUPPORT. THANK YOU FOR THIS RECOGNITION, I APPRECIATE IT VERY MUCH. 

SUP. ANTONOVICH: THIS IS A PUBLIC/PRIVATE PARTNERSHIP TO SHOW YOU HOW IMPORTANT IT IS TO HAVE THE PRIVATE SUPPORT WITH PUBLIC/PRIVATE PARTNERSHIPS TO HELP OUR YOUTH. OKAY. LET'S DO A GROUP PICTURE. NOW WE HAVE LITTLE HARRIS WHO IS A TERRIER MIX WHO IS FIVE YEARS OLD. LOOKING FOR A HOME. HE LOVES THE MILITARY. I KNOW THERE ARE A LOT OF VETERANS OUT THERE. SO 562-728-4610 TO ADOPT LITTLE MORRIS. HE'S FIVE WEEKS OLD. EXCUSE ME FIVE MONTHS OLD. AND HE'S LOOKING FOR A NICE HOME. HE WILL BRING YOU A LOT OF LOVE. HE'S FROM FRANCE. [LAUGHTER.] THAT WAS A WET ONE, MORRIS -- HARRIS, I SHOULD SAY. WOW. ANYWAYS, LOOKING FOR A HOME. ANYBODY LIKE TO ADOPT HIM? HE'S LOVEABLE. [LAUGHTER.] 

SUP. KNABE, CHAIRMAN: DR. CLAVREAUL, ITEMS 1, 11 AND 15. PREVEN, 2-D, 5, 14, 17, 19, 21, 26, 27, 29 AND 30. SACHS, 1-D, 2-D, 11, 17, 20, AND 22. AND ROBERT LUCAS ON 2-D. 

ERIC PREVEN: DO YOU WANT ME TO PROCEED? IT'S ERIC PREVEN COUNTY RESIDENT FROM DISTRICT 3. AND I JUST WANT TO MAKE A COMMENT ABOUT THESE CONTINUATIONS. SOME OF THESE ITEMS ARE BEING CONTINUED TODAY RIGHT HERE IN THE MOMENT. THAT DOES NOT SEEM APPROPRIATE FOR THE INDIVIDUALS WHO HAVE COME DOWN. I KNOW YOU CHANGE THE RULES, SIR, AT THE BEGINNING OF YOUR TERM. THAT DOES NOT SEEM APPROPRIATE TO ME THAT PEOPLE COME DOWN TO SPEAK, FOR EXAMPLE, ON ITEM 6 AND THEY SAY "OH WE'RE CONTINUING IT FOR TWO WEEKS, YOU CAN TALK ABOUT IT IN PUBLIC COMMENT" IT SEEMS INAPPROPRIATE, TO ME. ITEM NO. 2-D, IS OF COURSE A LITTLE R.F.P. FOR A MILLION DOLLARS PUT ON BY THE COMMUNITY DEVELOPMENT COMMISSION. OH. AND THIS IS FOR HOMELESS YOUTH PROGRAMMING OF SOME KIND. IT'S VERY, VERY POSITIVE. IT'S UNDERSPENT MONEY. BUT TO ME, THIS IS -- IT ASKS, THE ASK IS HUGE. IT SAYS BASICALLY WE'RE LOOKING FOR FOLKS WHO CAN HELP IN ALMOST ANY CATEGORY OF THIS GROUP. I WONDER IF DOING R.F.P.S THAT ARE MORE FOCUSED ON THE URGENT SPECIFIC NEED WOULD BRING OUT REASONABLE COMPETITION BETWEEN ENTITIES WHO ARE WORKING LIKE THAT? AS OPPOSED TO A KIND OF GENERIC BEAUTY CONTEST WHEREBY, YOU KNOW, SOMEBODY JUST PICKS. BECAUSE THEY ALL DO DIFFERENT THINGS AND THEY'RE NOT EXACTLY COMPARABLE. THAT WAS SOMETHING THAT I WAS THINKING ABOUT. ITEM NO. 5 IS ZEV YAROSLAVSKY'S GIVING THANK YOU $16,000 IN WAIVED RECEIPTS TO THE SURF RIDER GROUP OUT IN MALIBU. IT'S OBVIOUSLY A POSITIVE THING. IT MADE ME REMEMBER, HOWEVER, THE TRIATHLON THAT WAS SPONSORED BY NAUTICA, ZEV LOOKS GREAT IN NAUTICA, BY THE WAY, BUT MY QUESTION FOR YOU IS WHO IS THE SPONSOR OF THIS PARTICULAR EVENT BECAUSE I THINK IT'S IMPORTANT THAT WE PUBLISH THAT IN THE AGENDA AS I TOLD JOEL BELLMAN TWO YEARS AGO. ITEM NO. 6 WAS THE ONE I WAS TALKING ABOUT WAS CONTINUED. ITEM 17 IS MORE LIBRARY PROCUREMENT. NOW THE LIBRARY GROUP HAS ITS OWN LITTLE PROCUREMENT TEAM. AND HERE THEY GOT A GRIFFIN SWINNERTON DEAL FOR A LIBRARY THAT MAYOR ANTONOVICH IS PRESIDING OVER NICELY. THEY GOT A $1.78 MILLION DOLLAR OPTION TO HELP US GET THIS LIBRARY GOING. THE ONLY THING I WOULD ASK IS THAT WE TRIPLE CHECK AND LOOK CLOSELY AND HERE'S WHY. BECAUSE THAT LIBRARY PROCUREMENT GROUP IS FAMOUS IN COUNTY GOVERNMENT FOR BEING THE LAST MAN STANDING TO SAY "DIAMOND CONTRACT SERVICES IS THE BEST" THEY DID THAT ABOUT A MONTH OR SO BEFORE THE MASSIVE IMPLOSION AT DIAMOND CONTRACT SERVICES, WHICH IS A GROUP THAT HAS CRUMBLED IN A WAY THAT'S UPSETTING GIVEN THEIR BIG, BIG BUSINESS, IT'S EATEN UP LOTS OF JANITORIAL CONTRACTS. ITEM NO. 19 IS THE O'ROURKE P.R. GROUP. GAIL FARBER AND THE FOLKS AT PUBLIC WORKS APPARENTLY FELT THAT THE 532 ARE THEIR FOLKS WHO COMPETED IN THIS R.F.P. INITIALLY DIDN'T HAVE WHAT THE INCUMBENT WAS AND THIS WAS FOR WATER REPORTING ABOUT P.R. AND STUFF. VERY IMPORTANT ISSUE GIVEN THESE HIGH DROUGHT CONDITIONS. BUT HERE'S THE THING. OF THE THIS WAS THE GROUP MUST HAVE BEEN INCUMBENT DURING THE CLEAN BEACHES CROOKED PAMPHLET IN THE MAIL PROGRAM THAT WE HAD, AS YOU RECALL. SO I WOULD URGE THAT WE RETHINK WHETHER OR NOT WE WANT TO JUST ROLL THAT RIGHT OVER. A LOT OF GOOD IDEAS. A LOT OF BRIGHT YOUNG MINDS IN THE MARKET THESE DAYS. THAT COULD BE HELPFUL. ITEM NO. 14 I'LL JUST SAY FOR MR. SALADINO, THE TREASURER TAX COLLECTOR WHO BELIEVES THAT 54 PERCENT IN FEES AND COSTS IS APPROPRIATE TO GO TO THE ATTORNEYS IN A SETTLEMENT WITH OUR HOSPITAL. I DON'T AGREE WITH THAT. AND I'VE ASKED HIM TO PUT SOME OF THE MATERIALS TOGETHER TO HELP SORT THROUGH HOW WE CAN SHUT THESE LAW FIRMS DOWN FROM DOING IT. 

SUP. KNABE, CHAIRMAN: NEXT? THREE MINUTE. 

DR. GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS, DR. GENEVIEVE CLAVREUL. YOU KNOW, ON ITEM NO. 6, ACTUALLY THIS MORNING WHEN WE RECEIVED THE CONTINUED ITEM, IT WAS NOT ON THE LIST TO BE CONTINUED. AND I THINK TO HAVE IT CONTINUE IS NOT VERY APPROPRIATE. ESPECIALLY ON THAT CONTINUED ITEM, IT DID NOT SAY IT WAS CONTINUED. IT SAID IT WAS A NO VOTE FROM SUPERVISOR YAROSLAVSKY AND KNABE. BUT, ANYWAY, THAT'S THE WAY WE ARE DOING THINGS LATELY. SO MUCH FOR TRANSPARENCY. ON ITEM 11, IT'S KIND OF SURPRISING THAT WE ARE AGAIN AGAIN TRYING TO BE MORE PROPERTY TO M.L.K., THAT NEW HOSPITAL WAS STILL A BIG DREAM. AND TO ASSIGN THE REQUEST FOR PROPOSAL TO BE DIRECTED TOWARD THE C.E.O. IS KIND OF INAPPROPRIATE BECAUSE AS FAR AS I KNOW, THE C.E.O. IS PLANNING TO LEAVE QUITE SOON. SO IT WOULD BE FAR BETTER TO WAIT TO ASSIGN IT TO SOMEBODY ELSE. BUT AS USUAL, THAT IS NOT THE WAY WE ARE DOING THINGS. ON ITEM 1, YOU KNOW, TO GIVE THE SCROLL FOR M.L.K. DREAM TEAM IS REALLY A MISNOMER BECAUSE YOU ARE NOT TALKING ABOUT THE M.L.K. HOSPITAL. YOU ARE TALKING ABOUT THE M.L.K. MACC. AND I THINK THAT'S A TOTAL MISREPRESENTATION. I REPEATEDLY ASK THIS MORNING WHO WAS THAT DREAM M.L.K. DREAM TEAM? SO, YOU KNOW IT IS KIND OF SAD THAT SEEING CANNOT BE DONE WITH THE RIGHT LABELING. ANYWAY, FOR YOUR READING PLEASURE, I WROTE AN ARTICLE ABOUT COURTESY. COURTESY AND MANNERS REALLY COUNT. AND I THINK MANY OF YOU SHOULD READ IT BUT ALSO MAYBE THE AUDIENCE WHO ARE NOT QUITE WELL-MANNERED SOMETIMES OR POLITE. YOU KNOW, IT COSTS OVER $6 BILLION A YEAR BECAUSE OF POOR MANNERS. MANY PEOPLE DON'T COME TO WORK BECAUSE THERE IS NOT GOOD MANNERS OR COURTESY. AND LET ME TELL YOU: SOMETIMES IT'S VERY DIFFICULT FOR ME TO COME TO THIS BOARD AND SEE THE LACK OF MANNERS. AND LIKE I SAID, NOT ONLY FROM THE BOARD, THE PUBLIC, AS WELL. SO I THINK PLEASE READ AND GIVE ME YOUR COMMENTS. THANK YOU. 

SUP. KNABE, CHAIRMAN: THANK YOU. NEXT? 

ROBERT LUCAS: MY NAME IS ROBERT LUCAS. ON THE 2-D AGENDA ITEM WITH THE MONEY THAT'S BEEN ALLOTTED FOR THE DELINQUENCY AND THE YOUTH FOR THE HOMELESS, I'D LIKE TO JUST ASK THAT EVEN THOUGH IT WAS MENTIONED THAT IT MIGHT BE UNDERFUNDED, I'D LIKE TO FIND OUT SOME MORE INFORMATION ON THIS BECAUSE I WOULD BE MORE THAN HAPPY TO VOLUNTEER BECAUSE I'M LIVING WITH SOME OF THE OLDER GENERATION OF THE EXACT SAME PROBLEM. AND I THINK THAT A VERY BIG INFLUENCING FACTOR IN PREVENTING SOME OF THE OLDER GENERATION IS CATCHING THEM AS YOUTH. AND WITH THE EXPERIENCE I HAVE, I THINK IT'S VITAL AND I'D LOVE TO VOLUNTEER FOR THAT. 

SUP. KNABE, CHAIRMAN: THERE SHOULD BE SOMEBODY HERE FROM COMMUNITY DEVELOPMENT COMMISSION THAT CAN TALK TO YOU AND SHOW YOU WHAT OPPORTUNITIES THEY HAVE FOR VOLUNTEERING. 

ROBERT LUCAS: THANK YOU. 

SUP. KNABE, CHAIRMAN: SO WHOEVER'S HERE FROM COMMUNITY DEVELOPMENT, IF YOU'D SPEAK TO THE GENTLEMAN, PLEASE, I'D APPRECIATE IT. NEXT? 

ARNOLD SACHS: YES, THANK YOU. GOOD MORNING, ARNOLD SACHS. AND I DID HOLD A FEW ITEMS, KNABE. I HELD ITEM 1-D, I'LL SKIP THAT, THOUGH. ITEM 2-D, THE HOMELESS PREVENTIVE IMITATIVE. AND SURPRISINGLY, THAT WAS ON YOUR AGENDA LAST YEAR, JUNE 4, 2013. TO REPROGRAM THE CURRENTLY UNSPENT COUNTYWIDE HOMELESS PREVENTION INITIATIVE ONE TIME FUNDS TO ENABLE THE BOARD TO EFFICIENTLY MAKE EXPENDITURES AND ENSURE AT LEAST 90 PERCENT OF THE RECOMMENDED PROGRAM FUNDS GO TO PERMANENT SUPPORTIVE HOUSING. THEN THERE IS THIS PART THAT YOU MADE AN AMENDMENT TO THE AGENDA. ADDITIONAL RESOURCES, INSTEAD OF 5 MILLION TO 10 MILLION FOR ANNUAL HOMELESS PREVENTIVE INITIATIVE ONGOING FUNDS, YOU STATED JUST ADDITIONAL RESOURCES ADDED TO THE HOMELESS PREVENTATIVE INITIATIVE ONLY AFTER THE REPROGRAM FUNDS HAVE BEEN EXPENDED. SO HOW'D YOU COME UP WITH A MILLION DOLLARS EXTRA? YOU JUST TALKING ABOUT SPENDING ALL THIS MONEY, AND LO AND BEHOLD YOU HAVE A MILLION DOLLARS EXTRA. HOW IS THAT POSSIBLE? I KNOW. SIX TIMES 12 IS 66. THAT GOES BACK TO YOUR TRASH HAULING. AND WHEN IT COMES TO TRASH, THIS BOARD HAS A LOT TO HAUL. I HELD ITEM NO. 11, R.F.P. FOR MEDICAL OFFICE BUILDING AT M.L.K. MEDICAL CAMPUS CENTER. AND THIS IS FROM JULY 29, 2014. MARK RIDLEY-THOMAS INSTRUCT THE CHIEF EXECUTIVE OFFICER AND DIRECTORS OF HEALTH SERVICES AND MENTAL HEALTH TO REPORT BACK IN 90 DAYS WITH A REPORT THAT IDENTIFIES REAL PROPERTY OR AVAILABLE UNDERUTILIZED COUNTY FACILITIES LOCATED ON COUNTY MEDICAL CAMPUSES THAT COULD BE MADE AVAILABLE FOR THE DEVELOPMENT OF PERMANENT SUPPORTIVE HOUSING, PSYCHIATRIC HEALTH CENTERS AND OTHER COUNTY-SUPPORTED FACILITIES. BLAH, BLAH, BLAH. WELL, WE HAVE FACILITIES HERE, BUT WE'RE USING IT FOR DOCTORS' OFFICES. THEN I HELD ITEM 17, IN MARCH, YOU TOOK $13 MILLION FOR THE SOUTH WHITTIER LIBRARY. AND YOU TRANSFERRED $5 MILLION FROM SOUTH WHITTIER LIBRARY AND ANOTHER $8 MILLION FROM THE EAST SAN GABRIEL LIBRARY ON 3/25 THAT WAS ACTION BY THE BOARD. ON 4/8 YOU TOOK 4 MILLION FROM THE EAST SAN GABRIEL VALLEY LIBRARY TO THE LOMITA LIBRARY. ON JULY 8TH YOU DID SOMETHING WITH ARTESIA LIBRARY. BUT NONE OF THOSE MENTIONED ANYTHING ABOUT A LEASE DESIGN AGREEMENT. AND THIS ONE, ACCORDING TO THE LIBRARY, IS A LEASE DESIGN AGREEMENT. HOW COME? WHAT ARE THEY LEASING? IT'S A LIBRARY. IT'S SUPPOSED TO BE A COUNTY FACILITY. I HELD ITEM 22, IT'S A 10 PERCENT CONTINGENCY FEE OF $2.6 MILLION. COUNTY'S LOCAL MATCHING FUNDS. IS THAT $26 MILLION? THE FEDERAL HIGHWAY ADMINISTRATION. BUT IT'S THE ANGELS FOREST NATIONAL HIGHWAY, ISN'T THAT A STATE HIGHWAY? SHOULDN'T THEY HAVE SOME MONEY INVOLVED HERE? I KNOW. COUNTY MATH. HAULING TRASH. DR. CLAVREUL, YOU MIGHT WANT TO GIVE HIM THE COPY OF YOUR COURTESY COUNTS ARTICLE. ALL RIGHT. NEXT? 

ARNOLD SACHS: WHEN IT STARTS WITH COURTESY, YOU HAVE A LONG WAY TO GO, SIR. 

SUP. KNABE, CHAIRMAN: THANK YOU. 

C.E.O. FUJIOKA: BEFORE YOU MOVE THESE ITEMS, I WOULD LIKE TO SPEAK TO ITEM NO. 11, PLEASE. 

SUP. KNABE, CHAIRMAN: OKAY. 

C.E.O. FUJIOKA: THERE'S BEEN SOME QUESTIONS AND CONCERNS HAVE BEEN RAISED. BUT YET THIS PROJECT I THINK IS AN IMPORTANT PROJECT, SO WHAT I'D LIKE TO DO RIGHT NOW IS ASK THAT YOUR BOARD APPROVE THE RELEASE OF THE R.F.Q. AND THEN ONCE WE GET A NUMBER OF FIRMS THAT ARE INTERESTED IN THIS EFFORT, WHO COME BACK, I WILL THEN RETURN TO THE BOARD WITH THE LIST OF AGENCIES OR ENTITIES THAT ARE INTERESTED IN WORKING ON THIS PROJECT. AND IT WILL GIVE US TIME TO ANSWER THOSE ISSUES AND CONCERNS THAT WE CAN EITHER ADDRESS THROUGH A BRIEFING BUT MORE LIKELY IN A REPORT BACK TO YOUR BOARD. THE OTHER THING I'D LIKE TO DO IS BECAUSE CURRENTLY THE WAY IT'S STRUCTURED THE R.F.Q. WILL BE ISSUED THROUGH A CONTRACTORS' WEBSITE. I WANT TO MAKE SURE WE HAVE A VERY BROAD DISTRIBUTION. AND I ASK THAT WE POST THIS R.F.Q. ON THE PUBLIC WORKS' WEBSITE BECAUSE THAT'S OUR STANDARD PROCESS. 

SUP. KNABE, CHAIRMAN: AS WELL AS THE OFFICE OF SMALL BUSINESS? 

C.E.O. FUJIOKA: AND OFFICE OF SMALL BUSINESS. SO I THINK THAT WILL HELP US, YOU KNOW, CAST THE WIDEST NET AND GET THE MOST QUALIFIED PROPOSER TO WORK ON THIS IMPORTANT PROJECT. SO I ASK THAT WE RELEASE THE R.F.Q. TODAY AND THAT ONCE WE GET THE -- IDENTIFY THOSE WHO ARE INTERESTED IN THIS EFFORT, I'D COME BACK TO THE BOARD AT THE SAME TIME IT WILL GIVE US THE OPPORTUNITY TO ADDRESS ANY ISSUES OR CONCERNS AND PROVIDE A GOOD BRIEFING AND THAT WE POST IT ON OUR STANDARD WEBSITE. 

SUP. KNABE, CHAIRMAN: OKAY. WITH THAT UNDERSTANDING, WE'RE GOING TO MOVE FORWARD WITH THE ITEM, ITEM 11, MOVED BY SUPERVISOR RIDLEY-THOMAS. THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. 

C.E.O. FUJIOKA: THANK YOU VERY MUCH. 

SUP. YAROSLAVSKY: EXCUSE ME. IS THE RELEASE OF THE R.F.Q., EVERYTHING ELSE IS BEING -- 

C.E.O. FUJIOKA: THAT'S WHAT'S BEING APPROVED TODAY. EVERYTHING ELSE WILL COME BACK. 

SUP. YAROSLAVSKY: THANK YOU. 

C.E.O. FUJIOKA: THANK YOU VERY MUCH. 

SUP. KNABE, CHAIRMAN: THE REMAINDER? 

SACHI HAMAI, EXEC. OFFICER: THE REMAINDER OF THE ITEMS ARE AS FOLLOWS. ITEM NO. 1-D, 2-D, 1, 5, 14, 15, 17, 19, 20, 21, 22, 26, 27, 29 AND 30. THOSE ITEMS ARE BEFORE YOU. 

SUP. KNABE, CHAIRMAN: ON THOSE ITEMS, MOVED BY SUPERVISOR YAROSLAVSKY. THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO BE THE ORDER. 

SACHI HAMAI, EXEC. OFFICER: THANK YOU. 

SUP. YAROSLAVSKY: 42-A IS BEING TAKEN UP IN CONJUNCTION WITH THE DISCUSSION ITEM? 

SACHI HAMAI, EXEC. OFFICER: YES. 

SUP. YAROSLAVSKY: THANK YOU. 

SACHI HAMAI, EXEC. OFFICER: 42-A, THERE ARE ALSO A NUMBER OF INDIVIDUALS WHO ARE HOLDING IT. 

SUP. YAROSLAVSKY: THANK YOU. 

SUP. KNABE, CHAIRMAN: WE WILL CALL ITEM NO. 40, THE REPORT BY D.P.S.S. 

SHERYL SPILLER: GOOD MORNING, CHAIR AND SUPERVISORS. I'M SHERYL SPILLER, DIRECTOR OF THE DEPARTMENT OF PUBLIC SOCIAL SERVICES. AND AS REQUESTED, I'M HERE TO GIVE YOU AN UPDATE ON MY DEPARTMENT'S ROLE AND OUR PROGRESS IN THE IMPLEMENTATION OF THE AFFORDABLE CARE ACT AND THE ONGOING MAINTENANCE OF MEDI-CAL CASES. WHILE HEALTH SERVICES IS FOCUSING ON THE EXPANSION OF HEALTHCARE PROVIDERS NEEDED TO DELIVER SERVICES TO MEET THE NEEDS AND DEMANDS OF THE INCREASED ENROLLMENT, D.P.S.S.' FOCUS IS ON ESTABLISHING AND MAINTAINING MEDI-CAL ELIGIBILITY. THIS MEANS THAT ALL OF THE APPLICATIONS SUBMITTED BY L.A. COUNTY RESIDENTS, WHETHER THEY GO THROUGH HEALTH SERVICES, THROUGH CLINICS, THROUGH CERTIFIED ENROLLMENT COUNSELORS, THROUGH PRIVATE HOSPITALS TO COVER CALIFORNIA, THEY ALL COME TO D.P.S.S. TO BE PROCESSED FOR -- TO COMPLETE THE ENROLLMENT PROCESS. NOW, SINCE JANUARY 2014, WE'VE RECEIVED OVER 400,000 APPLICATIONS. THAT'S ALONG WITH THOSE 300,000 HEALTHY WAY L.A. CASES THAT WERE CONVERTED TO MEDI-CAL. NOW, DETERMINING MEDI-CAL ELIGIBILITY RELIES NOT JUST ON OUR LOCAL SYSTEM, WHICH IS LEADER, IT ALSO IS RELYING ON THE STATE'S CAL-HEARS SYSTEM. AND WHILE AUTOMATION HAS BEEN MADE EASIER FOR INDIVIDUALS TO APPLY TO MEDI-CAL, THE CAL-HEARS SYSTEM CONTINUES TO DELAY ACCESS TO CARE. PRIOR TO HEALTH CARE REFORM D.P.S.S. CONSISTENTLY MET THE STATE'S MANDATE TO ESTABLISH MEDI-CAL ELIGIBILITY WITHIN 45 DAYS. THE STATE'S REQUIREMENT THAT MEDI-CAL APPLICATIONS NOW ALL GO THROUGH CAL-HEARS HAS CONTRIBUTED TO 187,000 PENDING APPLICATIONS IN L.A. COUNTY ALONE. NOW TO ASSIST INDIVIDUALS WITH PENDING APPLICATIONS WHO HAVE SCHEDULED DOCTOR APPOINTMENTS OR OTHER IMMEDIATE NEEDS MY STAFF ARE CIRCUMVENTING THE SYSTEM AND ISSUING BENEFITS DIRECTLY ONLINE THROUGH MEDS. IN ADDITION TO PROCESSING APPLICATIONS, COUNTIES ARE REQUIRED TO RE-ESTABLISH MEDI-CAL ELIGIBILITY. THIS IS REFERRED TO AS RENEWAL. BECAUSE OF PROBLEMS WITH CAL-HEARS THE STATE SUSPENDED RENEWALS FROM JANUARY THROUGH MAY OF THIS YEAR. IN MAY, THE STATE INSTRUCTED THE COUNTIES TO MAIL OUT RENEWAL PACKETS. OUR COUNTY MAILED OUT OVER 140,000 RENEWAL PACKETS FOR JANUARY AND JUNE. LAST MONTH, I REPORTED THAT 52 PERCENT OF THOSE CASES WERE AT RISK OF TERMINATING FOR FAILURE TO RETURN THOSE RENEWAL PACKETS. I REPORTED TO THE BOARD THAT MY DEPARTMENT WAS TAKING ACTION TO REDUCE THE NUMBER OF POTENTIAL TERMINATIONS. THAT WOULD HAVE MEANT THAT THOSE PEOPLE WHO HAVE BEEN ENROLLED, AT LEAST 52 PERCENT OF THOSE PEOPLE WOULD NOW BE WITHOUT HEALTH COVERAGE ONCE AGAIN. I'M HAPPY TO REPORT THAT WE SUCCESSFULLY REDUCED THE PERCENTAGE OF PERSONS THAT WERE AT RISK OF TERMINATION FROM 52 PERCENT TO 25 PERCENT. AND WE DID THAT BY COMPLETING EX PARTE REVIEWS, WHICH MEANS WE LOOKED AT ACTIVE CALFRESH AND G.R. SEGMENTS. WE ALSO MAILED REMINDER NOTICES. WE INITIATED AUTOMATED OUTBOUND CALLS AND LASTLY WE HAD ELIGIBILITY STAFF TO TELEPHONE BENEFICIARIES ON EVENINGS AND ON SATURDAYS. RECENTLY, THE STATE ASKED THE COUNTIES TO WORK WITH OUR MANAGED CARE PARTNERS TO OUTREACH TO THEIR PATIENTS AND HAVE THEM TO RETURN THE RENEWAL PACKETS IN ORDER TO HELP THEM TO RETAIN THEIR HEALTH COVERAGE. THEREFORE, UNTIL WE'VE EXHAUSTED EVERY REASONABLE OUTREACH EFFORT, WE'RE NOT GOING TO TERMINATE ANY MEDI-CAL CASE FOR FAILURE TO COMPLETE THE RENEWAL PROCESS. AS FAR AS THE NEXT STEPS, LAST MONTH, YOU ASKED WHAT YOUR BOARD COULD DO TO ASSIST MY DEPARTMENT WITH THE AFFORDABLE CARE ACT IMPLEMENTATION. SENATE BILL 1341 IS CURRENTLY GOING THROUGH THE LEGISLATIVE PROCESS. THIS BILL WOULD LIMIT THE ROLE OF CAL-HEARS AND REQUIRE PROGRAMMING INTO LOCAL SYSTEMS WHICH WILL HELP IN EXPEDITING THE PROCESSING OF MEDI-CAL APPLICATIONS AND RENEWALS. WHILE THE BILL IS ALREADY SUPPORTED BY THE COUNTY, C.W.D.S., S.E.I.U AND THE WESTERN CENTER OF LAW AND POVERTY, WE'RE ASKING THAT YOUR BOARD SIGN A LETTER TO THE GOVERNOR IN SUPPORT OF THIS BILL. MY DEPARTMENT WILL CONTINUE TO DO ALL WE CAN TO ASSIST THE RESIDENTS IN RETAINING THEIR MEDI-CAL COVERAGE. ALSO WE'LL KEEP YOU INFORMED OF OUR PROGRESS AT THE REGULAR QUARTERLY DEPARTMENTAL A.C.A. UPDATES. 

SUP. KNABE, CHAIRMAN: ARE THERE ANY QUESTIONS? IS THERE ANY TIMELINE AS TO WHEN THEIR SYSTEM WILL BE ABLE TO TALK TO OUR SYSTEM? 

SHERYL SPILLER: THEY ARE STILL WORKING ON IT. THERE IS AN INTERFACE. THE INTERFACE HAS IMPROVED BUT I THINK REALLY THE PROBLEM IT'S JUST WITH THE PROGRAMMING OF THEIR SYSTEM. IT'S SLOW AND IT'S STILL COMING BACK WITH INACCURATE RESULTS. AND THE FEDS HAVE BEEN INVOLVED, TOO, TO TALK TO THE STATE TO -- AND THEY'RE REPORTING BACK TO THE FEDS ON THEIR PROGRESS. 

SUP. KNABE, CHAIRMAN: ALL RIGHT. SO WE GOT A BUNCH OF EYES ON IT, JUST NO RESULTS, IS THAT CORRECT? 

SHERYL SPILLER: PRETTY MUCH. WE'RE WORKING WITH THE CASES THAT WE HAVE HERE. AND WE'RE MAKING SURE THAT THE BENEFICIARIES THAT WE SIGNED UP IN CASE THEY HAVE EMERGENCIES TO SEE DOCTORS ARE GOING AND JUST WORKING AROUND THE SYSTEM IN ORDER TO ASSURE THAT THEY HAVE THE COVERAGE THEY NEED. 

SUP. KNABE, CHAIRMAN: OKAY. ANY OTHER QUESTIONS? IF NOT, THEN WE HAVE ONE BUT YOU DO WANT US TO TAKE THE ACTION TO DO THE LETTER? 

SHERYL SPILLER: YES, I THINK THAT IT WOULD BE HELPFUL TO HAVE THE LETTER. 

SUP. KNABE, CHAIRMAN: OKAY WE'LL PUT THAT ON THE FLOOR, SECONDED BY SUPERVISOR RIDLEY-THOMAS. AND THEN PUBLIC COMMENT, ARNOLD SACHS. THANK YOU VERY MUCH. 

SHERYL SPILLER: THANK YOU. 

ARNOLD SACHS: I'M TRYING TO BE MANNERLY EVEN THOUGH IT WILL KILL ME. NOBODY MENTIONED ANYTHING ABOUT MONEY INVOLVED AND WHEN IT COMES TO THE COUNTY IT'S ALL ABOUT MONEY, BUT THE WOMAN DID MENTION THEY HAVE 187,000 PENDING APPLICATIONS. AND THEY'RE HOLDING 140,000 RENEWAL PACKETS. THAT'S A TOTAL OF 327,000? OR IS THAT 140 RENEWAL PACKETS PART OF THE 187,000 PENDING APPLICATIONS. SO, DON'T KNOW. BUT DO KNOW COUNTY MATH. AND THAT'S AN F. SO MAYBE YOU COULD GET A CLARIFICATION ON THAT BECAUSE IT SOUNDS REALLY BAD IF IT'S 327,000. OR IS IT JUST 47,000 PENDING APPLICATIONS AND 140 RENEWAL PACKETS ARE PART OF THE 187,000 PENDING APPLICATIONS. THAT'S THE COUNTY'S DOUBLE TALK. MAYBE THE CHAIRPERSON WOULD BE SO KIND, BECAUSE WE KNOW HOW MANNERLY HE IS, THAT HE WOULD EXPLAIN IT. I'M SERIOUSLY DOUBTING THAT, THOUGH, ON ALL ACCOUNTS. 

SUP. KNABE, CHAIRMAN: THANK YOU FOR YOUR KIND WORDS. THAT ITEM'S BEFORE US WITH THE REQUEST FOR THE LETTER. AND MOVED BY SUPERVISOR RIDLEY-THOMAS. THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. WE'LL CALL UP ITEM 41, REPORT BY DIRECTOR OF MILITARY AND VETERANS AFFAIRS. 42-B WILL ALSO BE ON THE TABLE, THEN, TOO. WE JUST CALLED THE -- RIGHT. 

RUTH WONG: GOOD MORNING, SUPERVISORS. RUTH WONG, DIRECTOR OF MILITARY AND VETERANS AFFAIRS. AND BESIDE ME, I HAVE COMMISSIONER BOB ARCHULETA AN, FIRST DISTRICT APPOINTEE AND CHAIRMAN OF THE VETERANS ADVISORY COMMISSION. AND HE IS ALSO A PRESIDENTIAL APPOINTEE TO WEST POINT. SO MR. ARCHILETTA WILL BE GIVING THE REPORT. 

BOB ARCHULETA: THANK YOU SO MUCH, IF I MAY, MR. PRESIDENT? THE COMMISSION, THE L.A. COUNTY COMMISSION OF MILITARY AND VETERANS AFFAIRS WOULD LIKE TO EXPRESS THEIR EXTREME GRATITUDE TO THE BOARD OF SUPERVISORS FOR STANDING BEHIND THE VETERANS AS YOU HAVE IN THE PAST AND AS YOU HAVE ON THIS ISSUE. THE ISSUE AT HAND IS THE V.A. LAND IN WESTWOOD THAT BELONGS TO THE VETERANS. IN 1888, A DEED WAS CREATED A CHARITABLE AND PUBLIC TRUST UNDER WHICH THE NATIONAL HOME ASSUMED A LEGALLY IMPOSED FIDUCIARY DUTY AS TRUSTEE TO PERMANENTLY USE THE DONATED LANDS SOLELY AND EXCLUSIVELY AS A HOME FOR THE BENEFIT OF DISABLED VETERANS. CONSEQUENTLY, A SUCCESSOR TO THE NATIONAL HOME, THE VETERANS' ADMINISTRATION, THE V.A., NOW HOLDS THE DONATED LAND ONLY IN ITS CAPACITY OF A TRUSTEE AND IS SUBJECT TO SUCH LEGALLY IMPOSED FIDUCIARY TRUSTEE DUTIES THAT MUST BE HONORED IN PERPETUITY. UNDER APPLICABLE LAW, THE DONATED LAND MUST BE PERMANENTLY USED IN A MANNER THAT DIRECTLY CONTRIBUTES TO THE PROVISIONS OF THE HOME FOR THE BENEFIT OF DISABLED VETERANS AND THE V.A. IS NOT PERMITTED TO DIVERT THE USE OF THIS LAND FOR ANY OTHER PURPOSE. AND OUR ISSUE IS THAT THE LAND HAS BEEN USED FOR OTHER THAN VETERANS' USE. AND THIS IS WHY THE LETTER THAT WAS SENT TO YOU, SIGNED BY ME, ON MARCH 14TH OF THIS YEAR BY THE VETERANS COMMISSION ASKING THAT THE ENTIRE BOARD STAND BEHIND THE COMMISSION AND THE VETERANS AND THE COUNTY OF LOS ANGELES IN REFERENCE TO THE NINE LEASES THAT WERE ILLEGALLY SIGNED AND ISSUED BY PERSONNEL IN THE V.A. AND THE DEPARTMENT OF VETERANS AFFAIRS OF WEST LOS ANGELES HAS BEEN LEASING V.A. LAND TO VARIOUS ENTITIES FOR NONVETERAN USE FOR MORE THAN 20 YEARS. AFTER 15 YEARS, NONVETERAN ENTITIES NOW OCCUPY NEARLY 1/3 OF THE CALIFORNIA VETERANS' HOME CAMPUS, IT'S GONE TO FEDERAL COURT AND JUDGE OTERO'S ORDER SPECIFICALLY STATES THAT THESE LEASES AND THESE LEASE AGREEMENTS ARE UNAUTHORIZED BY LAW AND THEREFORE VOID. SO THE LOS ANGELES VETERANS HOME WAS AUTHORIZED BY AN ACT OF CONGRESS, AS I HAD MENTIONED. SOLELY FOR THE USE OF VETERANS. AND WE'D LIKE TO THANK THE BOARD OF SUPERVISORS FOR STANDING ONCE AGAIN BEHIND THE VETERANS IN SENDING THE LETTER TO JUDGE OTERO IN SUPPORT OF HIS RULING. AND I'D LIKE TO AGAIN THANK YOU ON BEHALF OF ALL THE VETERANS IN THE COUNTY OF LOS ANGELES FOR YOUR SUPPORT. 

SUP. KNABE, CHAIRMAN: THANK YOU. DO YOU HAVE ANYTHING TO ADD? OKAY. THANK YOU. THAT'S A RECEIVE AND FILE ITEM. SO WE WILL MOVE TO ITEM -- PARDON ME? 

SUP. YAROSLAVSKY:DO YOU HAVE 42-B? 

SUP. KNABE, CHAIRMAN: 42-B, I HAVE SPEAKERS ON, RIGHT? OR THE SAME ONE. 

SUP. YAROSLAVSKY: 42-A. THAT'S RELATED TO THIS. I MIGHT HAVE AN AMENDMENT AFTER THE PUBLIC HEARING. 

SUP. KNABE, CHAIRMAN: ALRIGHT, WE HAVE 42-A AND 41 IS A RECEIVE AND FILE. 42-A IS THE ISSUE BEFORE US. BOB ARCHULETA SPOKE ALREADY. ROBERT ROSEBROCK, HOWARD HERNANDEZ, FRANCISCO JUAREZ. ARNOLD SACHS. 

ROBERT ROSEBROCK: GOOD MORNING. ROBERT ROSEBROCK, OLD VETERANS GUARD. THANK YOU VERY MUCH. FIRST WOULD LIKE TO THANK SUPERVISOR ANTONOVICH AND YOUR LEADERSHIP TO PUSH THIS MATTER FORWARD FOR A FIVE-SIGNATURE LETTER SUPPORTING THE JUDGMENT. AND I'M GOING TO THANK COMMISSIONER ARCHILETTA FOR LAYING OUT OUR CASE. IT'S VERY, VERY IMPORTANT THAT WE ALL FOLLOW THE RULE OF LAW IN A CIVIL SOCIETY. ONE OF THE REASONS WE HAVE A CONSTITUTION IS BECAUSE BRAVE YOUNG MEN AND WOMEN DEFEND THAT CONSTITUTION. AND WHEN THEY COME BACK INJURED IN THE DEFENSE OF THAT CONSTITUTION, IT SEEMS LIKE THE LEAST THAT THIS GRATEFUL SOCIETY SHOULD BE ABLE TO DO IS TO CONTINUE TO PROVIDE QUALITY HOUSING FOR THOSE THAT NEED SUPPORTIVE HOUSING ON THE VERY LAND THAT WAS GIVEN ON THEIR BEHALF 126 YEARS AGO. THE FACT THAT THIS IS BEING OVERRUN, TAKEN OVER BY SPECIAL INTERESTS, NONPROFITS AND WHATNOT IS SHAMEFUL. IT IS SIMPLY SHAMEFUL. WE HAVE AN OPPORTUNITY RIGHT NOW TO CORRECT THAT WRONG. AND ACCORDINGLY, I WANT TO RESPECTFULLY REQUEST THAT EACH MEMBER OF THE BOARD PUT THEIR SIGNATURE ON THAT LETTER AND SUPPORT THE FEDERAL JUDGMENT AGAINST THOSE NINE ILLEGAL REAL ESTATE DEALS THAT HAVE BEEN DEPRIVING DISABLED HOMELESS VETERANS FROM THE PROPER HOUSING AND THE CARE THAT THEY RIGHTFULLY EARNED AND DESERVE. THANK YOU VERY MUCH. 

SUP. KNABE, CHAIRMAN: THANK YOU. NEXT? 

HOWARD HERNANDEZ: YES, I'M HOWARD HERNANDEZ. I'M WITH THE AMERICAN G.I. FORUM. AS I STATED LAST WEEK I'M THE FORMER STATE COMMANDER WITH THE AMERICAN G.I. FORUM. I'M PROVIDING EACH OF YOU A RESOLUTION OF THE UNLAWFUL SEIZURE OF THE WEST LOS ANGELES PROPERTY. NOW, THIS WAS A RESOLUTION THAT WAS ACCEPTED AND ADOPTED BY THE STATE OF CALIFORNIA AT OUR STATE CONVENTION UP IN SACRAMENTO. NOW, IN ADDITION TO THIS, I HAVE ALSO BEEN IN WASHINGTON, D.C. TO LOBBY AND TO MAKE SURE THAT THE ADMINISTRATION, I MET WITH THE VETERANS' LIAISON FOR THE CURRENT ADMINISTRATION IN WASHINGTON, D.C. AND ALSO WITH A SUBSTANTIAL NUMBER OF THE CONGRESSMEN ON THE HILL. MY CONCERN IS: I WAS UNAWARE, ONE, THAT THIS LETTER HAD BEEN COMPLETED IN APRIL. I DON'T SEE WHY IT'S BEEN HELD UP SO LONG. BUT FOR THE LAST TWO YEARS AS I INDICATED, I LOBBIED ON THE HILL AND I WILL CONTINUE TO LOBBY ON THE HILL. WE HAVE UNITED WITH SUBSTANTIAL NUMBER OF OTHER VETERANS' ORGANIZATIONS TO ENSURE THAT THIS PARTICULAR PROPERTY IS RETURNED AND UTILIZED FOR THE PURPOSE THAT IT WAS INITIALLY ESTABLISHED FOR. AND THAT WAS FOR THE BENEFIT OF OUR DISABLED AND HOMELESS VETERANS RETURNING. WE'RE PRIMARILY CONCERNED WITH OUR NEW RETURNING VETERANS BECAUSE THERE ARE A SUBSTANTIAL NUMBER OF THEM BECAUSE OF THE ADVANCES IN OUR MEDICAL WHO ARE GOING TO BE RETURNING HOMELESS. THEY'RE GOING TO BE RETURNING DISABLED. WE WANT TO GET THEM OFF THE STREETS. WE WANT TO HAVE THEM, GIVE THEM AN ALTERNATIVE. THE PROPERTY IS THERE. LET'S UTILIZE IT FOR THE PURPOSE THAT IT WAS ORIGINALLY ESTABLISHED FOR. 

FRANCISCO JUAREZ: FRANCISCO JUAREZ, OFFICE OF THE SACRED TRUST IN AMVETS CALIFORNIA. THIS EFFORT TODAY IS FOR DICK BRIGHTHOFF, NEWT YOUNG WHO STOOD AT THE PROTESTS UNTIL THEY DIED. TONY JACKSON UNITED STATES MARINE CORPS 1967. ANTONIO REJEZ AND MY GRANDSON, AND JIM PIDGEON. THE DELEGATES OF THE AMVETS NATIONAL CONVENTION HELD THIS PAST WEEK IN MEMPHIS, TENNESSEE PASSED A REVOLUTION TO ENDORSE AND SUPPORT JUDGE OTERO'S RULING, THE RESOLUTION ALSO CALLS TO REACH OUT TO OTHER V.S.O.S TO STAND SHOULDER TO SHOULDER TO STOP LAND GRAB ACROSS THE NATION. THIS FACILITY IS THE BIGGEST AND THE BUSIEST. SACRED TRUST IS WHAT THIS GRATEFUL NATION PROMISED TO VETERANS, VETERANS DID NOT MAKE THAT TERM UP. LAND GRAB HAS BEEN THE CANCER THAT HAS BEEN EATING AWAY AT IT, ESPECIALLY AT V.A. WEST L.A. YOUR CONCERNS FROM THE REPORTS OF THE POTHOLES IN YOUR DISTRICT TO THE WILLFUL TAKING OF THE LAND FOR YOUR VETERAN CONSTITUENTS SET ASIDE FOR HOUSING AND HEALING MUST BE SPOT ON. SUPERVISOR CANDIDATE, SUPERVISOR-ELECT SOLIS, PLEASE PAY CLOSE ATTENTION. DO NOT DRINK THE KOOL-AID. THANKS TO TECHNOLOGY, VETERANS ARE NETWORKED ACROSS THIS NATION. OVER THE RECENT COURSE OF THIS DEBATE, VETERAN ADVOCATES HAVE CONVINCED YOUR VETERAN ADVISORY COMMISSION TO DO THE RIGHT THING AND HOPEFULLY YOU ARE ABOUT TO FOLLOW THE LEAD, ALL FIVE OF YOU. HOWEVER, THE ATTEMPTS TO LAND GRAB THE HOME HAVE A LONG HISTORY, AND YOU SHOULD KNOW THE DIRTY DETAILS. IF YOU DON'T KNOW HOW MANY TIMES PEOPLE AND GOVERNMENTS HAVE ATTEMPTED TO TAKE THE HOME FROM THE VETERAN COMMUNITY, GOOGLE IT. IF YOU DO KNOW, SHAME ON YOU FOR NOT USING YOUR AUTHORITY TO CHALLENGE IT OR ALLOWING IT TO CONTINUE. UNLESS THIS BOARD IS STRICTLY DILIGENT, THE MATTER WILL NOT STOP WITH THIS MEETING OR WITH THIS DECISION. THIS TIME, SAVING THE HOME CALLS FOR MORE DIRECT ACTION THAN REITERATING THE ILLEGALITY OF NINE LEASES. YOUR DECISION TODAY MUST BE FOLLOWED UP TO END THIS DEBATE IN THE WORDS "PERMANENTLY MAINTAIN" AS STATED IN THE ACT OF 1887 AND THE DEED OF 1888 MUST BE STRONGLY REINFORCED BY YOU. THE ONLY STAKEHOLDER HERE IS THE VETERAN COMMUNITY AND IT HAS CALLED UPON YOU TO STOP LAND GRAB. 

SUP. KNABE, CHAIRMAN: PLEASE WRAP IT UP. 

FRANCISCO JUAREZ: PLEASE DO THE RIGHT THING. THE DEED IS THE ONLY MASTER PLAN. 

SUP. KNABE, CHAIRMAN: THANK YOU. NEXT? 

FRANCISCO JUAREZ: THANK YOU. 

ARNOLD SACHS: THANK YOU. I LIKE THE FIRST GENTLEMAN, HE DISCUSSED, OH, ARNOLD SACHS. FOLLOW THE RULE OF LAW. TALKING TO THE BOARD ABOUT FOLLOWING THE RULES OF LAW. WHOO. THIS IS FROM JUNE 22, 2011. V.A. PLAN CALLS FOR THREE OF THE 12 BUILDINGS TO BE RENOVATED ON THE PROPERTY. THIS IS FROM NOVEMBER 9, 2011. "JUDGE TELLS V.A. TO SETTLE WITH VETS." AT THAT TIME THE V.A. RECENTLY ENACTED A NEW MASTER PLAN FOR THE CAMPUS THAT PROVIDES FOR MORE VETERAN HOUSING ON THE SITE. WHERE WAS THE BOARD AT THAT TIME? DID THEY APPROVE OF THAT ACTION? I DON'T BELIEVE THEY DID ANYTHING. AND THEN THIS ONE IS FROM SEPTEMBER OF LAST YEAR. THE FEDERAL JUDGE MADE THE RIGHT DECISION WHEN HE RULED LAST WEEK THAT THE DEPARTMENT OF VETERAN AFFAIRS HAD MISUSED ITS WEST LOS ANGELES CAMPUS. LAST YEAR. PART OF THIS LAWSUIT FILED BY THE A.C.L.U. WAS TO COMPEL THE V.A. TO PROVIDE PERMANENT SUPPORTIVE HOUSING TO VETS. UNFORTUNATELY, THE JUDGE DISMISSED THAT ISSUE EARLY IN THE CASE. WHERE WAS THE BOARD ON THAT ACTION? I DON'T BELIEVE THEY DID ANYTHING. SO FOR THE 20 YEARS, GIVE OR TAKE, THAT'S AT THE END OF THE DAY, THE BOARD LIKES TO SAY, SOME BOARD MEMBERS, THAT'S 7,300 DAYS. PICK YOUR END. WHAT HAVE YOU DONE IN 20 YEARS FOR THE V.A. HOSPITAL? THIS ONE SAID THAT THEY STOPPED DOING HOUSING BACK IN THE '60S AND '70S BECAUSE THEY COULDN'T AFFORD IT. SO EXACTLY REALLY WHAT HAVE YOU DONE FOR HOUSING AT THE V.A. CENTER OUT IN THE WEST L.A.? I KNOW IT'S PART OF THE WEST L.A. AREA THAT WE DON'T WANT THOSE TYPE OF PEOPLE AROUND, BUT WHAT EXACTLY HAVE YOU DONE? WHAT EXACTLY? FOLLOW THE RULE OF LAW. YOU'RE IN THE BACK. THE PROBLEM IS YOU'RE WAY IN THE BACK. WAY BACK. 

SUP. KNABE, CHAIRMAN: THANK YOU. THANK YOU FOR YOUR VERY, VERY KIND COMMENTS. ALL RIGHT. THE ITEM IS -- 

SUP. YAROSLAVSKY: MR. CHAIRMAN? 

SUP. KNABE, CHAIRMAN: YOU CAN BITE IT OUTSIDE IF YOU WANT, KEEP IT UP. YES? 

SUP. YAROSLAVSKY: I'D LIKE TO MAKE AN AMENDMENT TO ITEM 42-A, AND I DISCUSSED IT WITH THE MAKER OF THE MOTION. FIRST, I'D LIKE TO ASK THE MAKER OF THE MOTION IF THE LETTER, IF THE FIVE-SIGNATURE LETTER COULD BE ADDRESSED TO THE SECRETARY OF THE V.A., NOT THE JUSTICE DEPARTMENT. I THINK THAT'S ON THE SUGGESTION OF THE COUNTY COUNSEL. 

SUP. KNABE, CHAIRMAN: YEAH, WE CAN COPY THE D.O.J. 

SUP. YAROSLAVSKY: THAT'S FINE. MR. CHAIRMAN, THIS IS A LONG, ONGOING SAGA, AS I THINK MANY IF NOT ALL THE BOARD MEMBERS KNOW, THIS BOARD HAS BEEN ON RECORD IN SUPPORT OF THE LEGISLATION THAT WAS CARRIED BY SENATOR FEINSTEIN AND CONGRESSMAN WAXMAN WHO REPRESENTS THAT AREA TO PREVENT THE V.A. PROPERTIES FROM BEING SOLD OFF, PARCELED OFF FOR PRIVATE USE OR FOR PRIVATIZATION BACK IN 2008 I BELIEVE THE YEAR WAS THAT THE LEGISLATION WAS FINALLY APPROVED AND SIGNED BY THE PRESIDENT UNDER DURESS AT THE TIME. THIS HAS NOT BEEN GOING ON FOR JUST 20 YEARS. IT'S BEEN GOING ON FOR PROBABLY MORE THAN 50 YEARS. ONE OF THE FACILITIES THAT WAS CAUGHT UP IN THIS COURT CASE WAS JACKIE ROBINSON STADIUM, WHICH IS U.C.L.A.'S BASEBALL STADIUM, WHICH HAS BEEN LEASING THE V.A. SINCE BEFORE I WAS IN COLLEGE. SO THAT'S A LONG TIME. SO IT'S BEEN AN ONGOING SAGA. AND CLEARLY THERE'S BEEN A PUSH AND PULL ON WHAT THE APPROPRIATE USE OF THE PROPERTY, THE V.A. PROPERTY IS AND THE APPROPRIATE USE OF THE PROPERTY IS FOR VETERANS SERVICES, PERIOD, OVER AND OUT. THAT'S WHAT THE PROPERTY WAS DEEDED FOR IN THE FIRST PLACE IN THE LATE 19TH CENTURY AND THAT'S WHAT IT SHOULD BE USED FOR. I WANTED TO OFFER AN AMENDMENT THAT ACKNOWLEDGES THAT THERE IS A MEDIATION PROCESS THAT IS GOING ON AS WE SPEAK. THIS COURT CASE ON ITS OWN ONLY DEALS WITH THE DISPOSITION OF THE LEASES. IT DOESN'T DEAL WITH ANY INCREASE IN SERVICES TO VETERANS, ANY ATTENTION TO THE NEEDS THAT THE VETERANS HAVE WHO ARE COMING BACK FROM WAR WHO HAVE AND FROM MANY WARS. NONE OF THAT IS ADDRESSED IN THIS CASE. BUT THE MEDIATION THAT'S GOING ON BETWEEN THE PLAINTIFFS AND THE V.A. APPEARS TO BE BEARING A GOOD DEAL OF FRUIT. AND I TALKED TO BOTH SIDES, BOTH ON THE A.C.L.U. SIDE AND ON THE V.A. SIDE AND THEY BELIEVE THAT THERE'S BEEN A LOT OF PROGRESS MADE. SO I WANT THE BOARD TO ENDORSE THAT MEDIATION PROCESS. AND SO I WANT TO READ THE FOLLOWING AMENDMENT IN. I THEREFORE MOVE THAT THE BOARD OF SUPERVISORS DIRECT THE EXECUTIVE OFFICER OF THE BOARD TO PREPARE AND SEND A FIVE SIGNATURE LETTER AND PERHAPS IT CAN BE SYNTHESIZED AND PART OF THE SAME LETTER SO WE ONLY HAVE ONE LETTER FROM THE LOS ANGELES COUNTY BOARD OF SUPERVISORS TO SECRETARY OF VETERANS AFFAIRS ROBERT A. MCDONALD AND TO THE A.C.L.U. FOUNDATION OF SOUTHERN CALIFORNIA WHO REPRESENTS THE PLAINTIFFS IN THIS CASE SUPPORTING THE ONGOING MEDIATION AND ENCOURAGING THE MEDIATION IN THE MANNER THAT RESOLVES THE DISPUTES THAT WERE AT ISSUE IN THE LAWSUIT. PRINCIPALLY EXPANDED SERVICES TO VETERANS WHO ARE HOMELESS AND HOW HAVE HEALTH, MENTAL HEALTH, SUBSTANCE ABUSE AND OTHER SERVICE-RELATED ISSUES. AND SECOND THAT WE DIRECT THE EXECUTIVE OFFICER OF THE BOARD TO SEND COPIES OF THE LETTER TO THE LOS ANGELES COUNTY CONGRESSIONAL DELEGATION, DIRECTOR OF THE V.A. OF THE GREATER LOS ANGELES HEALTHCARE SYSTEM AND THE COUNTY OF LOS ANGELES VETERANS ADVISORY COMMISSION. 

SUP. KNABE, CHAIRMAN: AND THAT'S IN ADDITION TO THE LETTER STILL SUPPORTING JUDGE OH OTERO'S DECISION. ARE YOU OKAY WITH THAT AMENDMENT? OKAY. 

SUP. ANTONOVICH: MY DEPUTY HAS SPOKEN WITH BOTH THE VETERAN'S ADVISORY COMMISSION REPRESENTATIVES FROM MY DISTRICT IS GARY CHAPMAN AND CARVEL GAY WHO SERVE ON THAT COMMISSION AND BOTH WERE SUPPORTIVE OF THE MOTION AND VOTED FOR THE ORIGINAL LETTER TO THE BOARD REQUESTING OUR SUPPORT OF JUDGE OTERO'S JUDGMENT. MY DEPUTY REGULARLY ATTENDS THE VETERAN'S ADVISORY COMMISSION MEETING AND IS IN CLOSE CONTACT WITH THE DEPARTMENT AND MY COMMISSIONERS AND SHE HAS ALWAYS BRIEFED ME. AND HER HUSBAND IS ON ACTIVE DUTY AT THIS TIME AND A VETERAN OF THE MIDDLE EASTERN WAR. THE LETTER BEING REQUESTED SENDS A STRONG MESSAGE THAT THE BOARD SUPPORTS THE VETERANS AND IS COMMITTED TO ADDRESSING THOSE CRITICAL NEEDS OF OUR HOMELESS VETERANS. WE MUST CONTINUE TO PURSUE AND SUPPORT PROGRAMS TO ADDRESS ALSO THE MENTAL HEALTH NEEDS OF OUR HOMELESS VETERANS WITH THE HOUSING COMPLEX, AS WELL. THIS IS AN ISSUE THAT SHOULD HAVE COME TO THE BOARD MONTHS AGO. AND I'M GLAD IT'S HERE TODAY SO WE CAN MOVE FORWARD BECAUSE IT IS AN ISSUE THAT DOES IMPACT THE ORIGINAL LANGUAGE OF THAT DEED, THE VETERANS' FACILITY. AND WE SHOULD BE SUPPORTING THOSE EFFORTS TO ASSURE THAT THAT DEED IS GOING TO BE RESPECTED AND CARRIED OUT, THE INTEGRITY OF THOSE WHO PROVIDED THAT PROPERTY TO THE COUNTY OF LOS ANGELES AGES AGO. 

SUP. KNABE, CHAIRMAN: OKAY. WITH THAT AS AMENDED AND WE WILL SEND THAT LETTER. MOVED BY SUPERVISOR ANTONOVICH. THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. THANK YOU. [APPLAUSE.] 

SUP. ANTONOVICH: ALSO SEND IT TO OUR CITIES. ALL THE CITY MAYORS AND COUNCILMEMBERS. 

SUP. KNABE, CHAIRMAN: WHAT? 

SUP. ANTONOVICH: SEND IT TO THE CITIES. 

SUP. YAROSLAVSKY: THAT'S AS AMENDED, CORRECT? 

SUP. KNABE, CHAIRMAN: YES. 

SUP. YAROSLAVSKY: IS IT POSSIBLE WE CAN SYNTHESIZE THE TWO LETTERS TO MAKE ONE? 

SUP. KNABE, CHAIRMAN: THAT WOULD BE GOOD. YEAH. 

SUP. YAROSLAVSKY: THANK YOU. 

SUP. KNABE, CHAIRMAN: CAN WE START ONE MINUTE EARLY? ITEM NO. 11, ITEM S-1. IT'S 11 O'CLOCK. REPORT BY THE TRANSITION TEAM OR SOMEBODY? GO AHEAD. ITEM IS S-1. 

LESLIE GILBERT-LURIE: GOOD MORNING. WE ARE HAPPY TO BE HERE BEFORE YOU, OUR FIRST TIME AS THE TRANSITION TEAM. AND UPDATE YOU AS TO WHERE WE ARE TO THIS POINT. GIVE YOU A FEW OF OUR THOUGHTS. I THINK I'M GOING TO BEGIN -- I'M LESLIE GILBERT-LURIE AND I'M COCHAIR WITH DR. KATZ OF THE TRANSITION TEAM. AND WE ALSO HAVE ANOTHER TEAM MEMBER HERE, TEAM MEMBER TEAGUE, JANET TEAGUE. SO, I JUST WANT TO EMPHASIZE UPFRONT THE SPIRIT IN WHICH WE'RE HERE AND THE SPIRIT IN WHICH WE ARE GOING ABOUT OUR TASK. WE DO NOT SEE OURSELVES IN ANY WAY AS ADVERSARIES TO THE BOARD OF SUPERVISORS. WE'RE HERE TO SUPPORT AND WHERE APPROPRIATE CHALLENGE YOU IN THE MOST CONSTRUCTIVE WAY FOR THE BENEFIT OF THE SAFETY OF OUR CHILDREN. AND WE WANT TO REMIND YOU THAT THE BLUE RIBBON COMMISSION RECOMMENDED AN OVERSIGHT TEAM SUCH AS OURS TO BEGIN WITH BECAUSE SUCH OVERSIGHT TEAMS HAVE BEEN AND ARE HELPFUL TO CHILD WELFARE SYSTEMS IN OTHER STATES AND REGIONS. WE BELIEVE THAT OUR RELATIONSHIP WITH YOU, AND THE MODEL THAT YOU SET IN DEALING WITH US IF POSITIVE AND COLLABORATIVE WILL ENCOURAGE THE BEST CANDIDATES TO APPLY FOR THE DIRECTOR OF THE OFFICE OF CHILD PROTECTION. SO I WAS GOING TO SAY A FEW WORDS TO YOU THIS MORNING ABOUT WHAT WE'VE BEEN THINKING ABOUT THE DIRECTOR OF THE OFFICE OF CHILD PROTECTION AND THEN DR. KATZ IS GOING TO TAKE IT FROM THERE. THE BLUE RIBBON COMMISSION HAD A FAIRLY SPECIFIC VISION OF THE QUALITIES THAT THE DIRECTOR OF THE OFFICE OF CHILD PROTECTION SHOULD ENCOMPASS. AND I JUST WANT TO SAY UP FRONT THAT A LOT OF THIS THINKING WAS DONE BY OUR LATE COMMISSIONER DR. ANDREA RICH, WHOM WE DEEPLY MISS AND WHOSE THINKING WAS INFUSED IN A GREAT DEAL OF OUR WORK. THE TRANSITION TEAM HAS ELABORATED ON THE QUALITIES THAT THE OFFICE OF CHILD PROTECTION SET TO BE SURE THAT YOU, THE BOARD OF SUPERVISORS, ARE CLEAR ON OUR VISION AS YOU BEGIN YOUR SEARCH. AS YOU CAN SEE FROM THE SUGGESTED LANGUAGE WE PROVIDED, WE URGE YOU TO PRESENT THIS POSITION AS A GREAT OPPORTUNITY AND A CHALLENGE FOR A VERY SPECIFIC INDIVIDUAL. WE STATED SPECIFICALLY IN OUR LANGUAGE THAT WE GAVE TO YOU WHICH WE SEE AS A DRAFT, BY THE WAY, IT DOES NEED TO BE TWEAKED AND WE WILL GET YOU REVISED LANGUAGE. BUT WHAT WE DID STATE SPECIFICALLY IS THAT THE FOUNDING DIRECTOR OF THE OFFICE OF CHILD PROTECTION WILL HAVE THE OPPORTUNITY TO FORGE A TRANSFORMATIONAL PROCESS FOR THE PROTECTION OF CHILDREN IN LOS ANGELES COUNTY. AND WE REALLY HOPE YOU SEE IT THE SAME WAY. THE TRANSITION TEAM ENVISIONS THE DIRECTOR AS HAVING A WIDE VARIETY OF TALENTS AND RESPONSIBILITIES THAT RANGE FROM WORKING WITH YOU TO SET A STRATEGIC VISION FOR CHILD SAFETY IN THE COUNTY TO LEVERAGING RESOURCES AND TALENTS OF ALL RELEVANT COUNTY AGENCIES, DEPARTMENTS AND COMMISSIONS, TO BREAKING DOWN SILOS. THE BLUE RIBBON COMMISSION AND NOW OUR TEAM THINKS IT'S VERY IMPORTANT THAT THE DIRECTOR BE EXTRAORDINARY. AT A MINIMUM, HE OR SHE SHOULD POSSESS THE FOLLOWING EXPERIENCES AND/OR TRAITS. ONE, HAVE HAD SUCCESS IN LEADING CHANGE IN COMPLEX ORGANIZATIONS. TWO, BE COMFORTABLE CHALLENGING EXISTING POLICIES AND STRONG LEADERS; THREE, HAVE A PASSION FOR PROTECTING CHILDREN AND BE WELL VERSED IN THE AREA OF CHILD SAFETY AND, FINALLY, HAVE EXPERIENCE WORKING POSITIVELY AND COLLABORATIVELY ACROSS GOVERNMENTS, AGENCIES OR DEPARTMENTS IN ORDER TO LEVERAGE TALENTS AND RESOURCES FOR THE GOOD OF THE ORGANIZATION AS A WHOLE. FOUR MEMBERS OF THE TRANSITION TEAM WERE ON THE BLUE RIBBON COMMISSION THAT ENVISIONED THE OFFICE OF CHILD PROTECTION AND ITS DIRECTOR. CONSEQUENTLY, WE BELIEVE WE COULD PLAY A VERY USEFUL, SUPPORTING ROLE IN YOUR SEARCH PROCESS BY MEETING YOUR TOP CANDIDATES AND PROVIDING YOU WITH FEEDBACK, JUST ADDITIONAL INFORMATION UPON WHICH YOU, THEN, CAN MAKE YOUR DECISION AS TO THE DIRECTOR. THE TRANSITION TEAM HOPEFULLY SEES ITSELF AS YOU ENVISIONED IT: WE'RE TRANSITIONAL. THE ENDURING STRUCTURE WE ARE HELPING TO CREATE MUST AND WILL CONTINUE BEYOND US. BUT THE DIRECTOR WILL NOT BE HIRED OVERNIGHT. WE HOPE TO BE AS USEFUL AS POSSIBLE IN HELPING YOU ATTRACT THE BEST PERSON POSSIBLE AND CONTINUING TO HELP YOU STRUCTURE WHAT THE OFFICE WILL LOOK LIKE IN THE MEANTIME. IN ADDITION, WE ENVISION FACILITATING AND MONITORING THE IMPLEMENTATION OF THE ADDITIONAL RECOMMENDATIONS UNTIL THE DIRECTOR'S IN PLACE AND FULLY FUNCTIONING. THANK YOU. 

DR. MITCHELL KATZ: GOOD MORNING, SUPERVISORS, DR. MITCH KATZ, DIRECTOR OF HEALTH SERVICES AND PROUD TO BE A COCHAIRMAN OF THE TRANSITION TEAM WITH LESLIE. THE SECOND DOCUMENT IN YOUR PACKET IS AN EXPLANATION OF HOW WE SEE THE ROLES AND RESPONSIBILITIES FOR THE TRANSITION TEAM. CLEARLY, WE NEED TO BE ON THE SAME PAGE AS THE BOARD SO THAT WE'RE DOING THE WORK THAT THE BOARD WANTS US TO DO AND SO THAT OUR WORK IS AS IMPACTFUL AS POSSIBLE. LESLIE HAS ALREADY EXPLAINED THAT WE HAVE, I THINK, PRETTY MUCH FINISHED THE FIRST JOB, WHICH IS WORKING ON THE JOB DESCRIPTION AND DESIRED QUALITIES AND EXPERIENCE OF THE DIRECTOR. I THINK OF ALL OF THE RESPONSIBILITIES LISTED, AMONG THE MOST IMPORTANT ARE TO IMPLEMENT AS RAPIDLY AS POSSIBLE THE RECOMMENDATIONS OF THE BLUE RIBBON COMMISSION. THAT WAS VERY CLEAR IN YOUR MOTION TO US. AND WE RECOGNIZE THAT IT MIGHT BE MANY MONTHS BEFORE THERE IS SOMEBODY IN THE OFFICE OF CHILD PROTECTION. AND WE WANT TO MAKE SURE THAT OUR CHILDREN DO NOT HAVE TO WAIT FOR THAT POSITION TO BE FILLED IN ORDER FOR THE RECOMMENDATIONS TO BE IMPLEMENTED. WE RECOGNIZE THAT SOME OF THE RECOMMENDATIONS, SUCH AS THOSE AROUND THE MEDICAL HUBS, THE PUBLIC HEALTH NURSES REQUIRE THAT DECISIONS ARE MADE. AND WE WANT TO BE ABLE TO WORK WITH THE DEPARTMENTS. WE FEEL THAT ONE OF THE THINGS THAT'S COME OUT VERY CLEARLY FROM THE DISCUSSIONS IS THAT THE CENTRAL ROLE BOTH FOR US AS A TRANSITION TEAM AND FOR THE OFFICE GOING FORWARD IS THE RECOGNITION THAT THE SERVICES THAT PROTECT CHILDREN ARE IN MULTIPLE DIFFERENT DEPARTMENTS. AND I THINK THAT IN DIFFERENT WAYS WE ALL COME BACK TO THAT. HOW DO WE TAKE THE SERVICES THAT ARE AVAILABLE IN THE D.A.'S OFFICE AND HEALTH SERVICES AND IN MENTAL HEALTH AND IN THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES. WE RECOGNIZE THERE IN ALL OF THOSE PLACES AND OTHER PLACES AND HOW DO WE COORDINATE THAT? BECAUSE NO MATTER HOW GOOD THE INDIVIDUAL DEPARTMENT HEADS ARE DOING THEIR RESPECTIVE JOBS, UNLESS THERE IS AN ACTIVE INTEGRATION OF THOSE ROLES, CHILDREN WILL NOT BE IN THE BEST POSITION. I WOULD LIKE TO ASK THE OTHER MEMBER IF SHE WOULD LIKE TO ADDRESS THE BOARD. 

JANET TEAGUE: I THINK YOU PRETTY OF SUMMED IT UP. 

DR. MITCHELL KATZ: THANK YOU, SUPERVISORS. 

SUP. ANTONOVICH: I HAVE SOME QUESTIONS. TO THE TRANSITION TEAM, YOU'RE IN A UNIQUE POSITION, DR. KATZ AS A DEPARTMENT HEAD WHO IS COCHAIRING THIS TRANSITION TEAM, FROM YOUR PERSPECTIVE, WHAT DO YOU SEE AS THE PRIORITY FOR THIS TRANSITION TEAM? 

DR. MITCHELL KATZ: I THINK TRYING GET THE DIFFERENT DEPARTMENTS THAT HAVE SOME PART OF THE PUZZLE TO FIGURE OUT HOW TO WORK TOGETHER TO MAKE CHILDREN SAFER. IT'S THE RECOGNIZING THAT ALL OF THE DEPARTMENTS MAY BE DOING THEIR JOB, BUT UNLESS PEOPLE ARE DOING THEIR JOB TOGETHER, CHILDREN ARE NOT MAXIMALLY PROTECTED. 

SUP. ANTONOVICH: AND, LESLIE, DID EACH MEMBER OF THE TRANSITION TEAM HAVE THE OPPORTUNITY TO REVIEW AND ALSO APPROVE THESE DOCUMENTS BEFORE THEY WERE SUBMITTED TO THE BOARD OF SUPERVISORS? 

LESLIE GILBERT-LURIE: YES. WE VOTED ON THEM AT THE LAST MEETING. 

SUP. ANTONOVICH: AND WAS IT A UNANIMOUS VOTE? 

LESLIE GILBERT-LURIE: YES. 

DR. MITCHELL KATZ: YES. 

LESLIE GILBERT-LURIE: AND AS I SAID, THIS IS ALL GOING VERY QUICKLY. WE SEE IT AS OUR ROLE AS NOT TO HOLD ANYTHING UP. NOT TO HOLD UP YOUR SEARCH. BUT THIS IS A WORK IN PROGRESS. SO THERE MIGHT BE DOCUMENTS WE'RE SUBMITTING TO YOU AND TWO WEEKS LATER, WE MIGHT HAVE ANOTHER IDEA WE FEEL THAT WE HAVE TO BE NIMBLE AND KEEP YOU UP TO SPEED AS TO THE BEST OF OUR THINKING. 

SUP. ANTONOVICH: CURRENTLY YOU HAVE STAFFING FROM THE C.E.O. AND THE EXECUTIVE OFFICE AND DEPARTMENT OF HEALTH. AND THAT STAFFING SHOULD BE SUFFICIENT FOR YOUR NEEDS? 

LESLIE GILBERT-LURIE: WE FEEL VERY STRONGLY THAT WE NEED AN EXECUTIVE DIRECTOR. THAT DIRECTOR COULD COME -- COULD WILL BE ALREADY EMPLOYED SOMEWHERE IN THE COUNTY AND BE LOANED TO US. BUT YOU HAVE HERDED A GROUP WITH A WIDE RANGE OF TALENTS. WE HAVE DOCTORS, PH.D.S, JUDGES, LAWYERS. IT'S A TALENTED GROUP WHOM I BELIEVE COULD BE VERY USEFUL TO THE PROCESS AS IT HAS IN A NUMBER OF OTHER STATES. BUT WE NEED SOMEONE WHOSE EYE IS REALLY ON THE BALL OF MOVING THIS FORWARD. THAT WAS VERY HELPFUL IN OUR BLUE RIBBON COMMISSION PROCESS. AND WE NEED SOMEONE LIKE THIS AVAILABLE TO AT LEAST -- DR. KATZ AND I FEEL THAT WAY -- WHO CAN REALLY GUIDE ALL OF OUR ENERGIES OVER THE NEXT THREE TO SIX MONTHS. 

SUP. KNABE, CHAIRMAN: WHAT'S WRONG WITH THE EXISTING STAFF THAT YOU HAVE? 

LESLIE GILBERT-LURIE: WE DON'T KNOW THAT WE HAVE AN EXECUTIVE DIRECTOR. 

SUP. KNABE, CHAIRMAN: YOU DON'T HAVE AN EXECUTIVE, THAT'S CORRECT. BUT FROM THE C.E.O.'S OFFICE AND HEALTH SERVICES, WHAT'S -- 

LESLIE GILBERT-LURIE: IT'S OUR POINT OF VIEW -- I CANNOT EXPRESS TO YOU HOW USEFUL IT WAS TO HAVE EILEEN ADAMS AND CHERYL GRILLS LEADING US IN THE BLUE RIBBON COMMISSION PROCESS. AND THERE ARE A LOT OF IDEAS. AND WE BELIEVE THERE'S A LOT OF INFORMATION THAT COULD BE HELPFUL IN WORKING WITH THE DEPARTMENT HEADS, LEVERAGING THE BEST OF WHAT YOU HAVE IN THE COUNTY. IF THERE IS SOMEONE AVAILABLE TO US TO TAKE OUR IDEAS AND HELP IMPLEMENT THEM WHEN WE'RE WORKING IN OUR DAY JOBS. WE DON'T BELIEVE -- WE BELIEVE WE'RE IMPOSING, IN A SENSE, WE DON'T BELIEVE WE HAVE ACCESS TO THAT SORT OF PERSON WITH THAT EXECUTIVE EXPERIENCE RIGHT NOW ON A FULL ENOUGH TIME BASIS. 

SUP. YAROSLAVSKY: YOU KNOW IF I COULD JUST ON THIS ONE ISSUE, WHAT BOTHERS ME ABOUT THIS IS: WE'RE NOT SEEING EYE TO EYE ON WHAT'S THE MOST IMPORTANT THING FOR US. THE MOST IMPORTANT THING FOR US TO DO RIGHT NOW IS TO GET THE OFFICE OF CHILD PROTECTION PERSON HIRED. NOW, IT'S BEEN PROBABLY A COUPLE OF MONTHS NOW SINCE WE HIRED THE SEARCH FIRM. THE SEARCH FIRM HAS OPERATED, IN MY OPINION, VERY SLOWLY. TOO SLOWLY. AND IS RESPONDING TO TOO MANY PEOPLE ABOUT THIS. AND WE ARE NOW IN AUGUST. AUGUST 19TH. AND WE ARE NO CLOSER TO HIRING OR EVEN SEARCHING FOR THE OFFICE OF CHILD PROTECTION PERSON THAN WE WERE A MONTH AGO. AND THEN WE GET SIDETRACKED BY THIS BUSINESS ABOUT TRANSITION TEAM WANTING A STAFF. I THINK YOU'VE BEEN OFFERED A STAFF. A NUMBER OF PEOPLE HAVE BEEN OFFERED UP, I'M TOLD BY THE EXECUTIVE OFFICE, BY THE C.E.O., BY MITCH HIMSELF. IT'S MORE IMPORTANT FOR US TO GET THE OFFICE OF CHILD PROTECTION HIRED THAN IT IS TO GET YOUR EXECUTIVE DIRECTOR HIRED. WE NEVER APPROVED A STAFF FOR THE TRANSITION TEAM. 

SUP. KNABE, CHAIRMAN: EXACTLY. 

SUP. YAROSLAVSKY: SO I, FRANKLY, WAS SURPRISED TO LEARN THAT THIS WAS LIKE A TRAIN THAT WAS LEAVING THE STATION. WE NEVER -- THIS IS OUR CALL. WE'RE GOING TO HAVE TO PAY FOR IT. AND WE NEED TO BE ON THE SAME PAGE. AND IT'S BEEN TWO SHIPS PASSING IN THE NIGHT. SO I TELL YOU MY FRUSTRATION IS AT THE RATE WE'RE GOING, TWO MEMBERS OF THIS BOARD ARE GOING TO LEAVE THIS BOARD HAVING HAD SIX MONTHS TO APPROVE AN OFFICE OF CHILD PROTECTION PERSON AND NOT HAVE HIM HIRED. AND I DON'T KNOW WHETHER THERE'S ANY -- I'M NOT DIRECTING THIS AT YOU. BUT WHETHER THERE'S IN THE SYSTEM ANY INTENTIONALITY TO HOLD THIS APPOINTMENT UP UNTIL SUPERVISOR MOLINA AND I ARE GONE, OR NOT. BUT IT LOOKS TO ME VERY, VERY SUSPICIOUS. EVEN WE CAN MOVE FASTER THAN THIS PARTICULAR HIRING SEARCH HAS MOVED. AND I'M AT THE POINT, MR. CHAIRMAN, THAT IF WE'RE NOT GOING TO GET ANY -- I KNOW WE'RE GOING TO DISCUSS THIS AT SOME POINT. IF WE'RE NOT GOING TO GET ANY TRACTION WITH OUR SEARCH FIRM, THEN WE MAY WANT TO JUST TAKE MATTERS IN OUR OWN HANDS. 

SUP. KNABE, CHAIRMAN: I MADE IT CLEAR TO THE SEARCH FIRM THAT SPEED IS OF THE ESSENCE AND IT NEEDS TO BE -- I MEAN I FELT THAT THE TRANSITION TEAM WAS PRESSURING THE SEARCH FIRM. AND HE FELT HE WAS RESPONDING TO THEM MORE SO THAN TO US. AND AT THE END OF THE DAY -- 

SUP. YAROSLAVSKY: I THINK IT'S PROBABLY TRUTH IN BOTH. I HAD A TALK WITH HIM, AS WE ALL DID, WHEN HE FIRST CAME ON BOARD. MR. OPPENHEIMER. OPPENHEIM OR OPPENHEIMER? OPPENHEIM. BUT WE'RE KIND OF ARGUING ABOUT THE SHAPE OF THE TABLE IN PARIS WHILE THE WAR IS GOING ON. 

SUP. KNABE, CHAIRMAN: YEP. 

SUP. YAROSLAVSKY: I'LL GIVE YOU ALL THE TIME YOU WANT. 

SUP. KNABE, CHAIRMAN: WELL, I'M THE CHAIR. 

SUP. YAROSLAVSKY: ALL THE TIME THAT THE CHAIR WILL ALOW ME TO GIVE YOU. ANYWAY. THAT'S MY POINT. 

SUP. ANTONOVICH: LET'S ASK THE C.E.O. ON THE STAFFING THAT YOU'RE PROVIDING. 

C.E.O. FUJIOKA: WELL, IN WORKING WITH YOUR EXECUTIVE OFFICE, SACHI HAMAI, WE HAVE STAFF WHO CAN STEP UP AND ASSIST THIS IMPORTANT EFFORT. I KNOW MS. HAMAI HAS ALSO IDENTIFIED AN INDIVIDUAL WHO I THINK IS HIGHLY QUALIFIED THAT CAN FUNCTION IN THE EXECUTIVE DIRECTOR ROLE. I THINK BETWEEN THE TWO OF US WE CAN JUST TAKE CARE OF THIS ONE ISSUE RIGHT AWAY. 

SUP. YAROSLAVSKY: THANK YOU. 

LESLIE GILBERT-LURIE: MAY I RESPOND? 

SUP. YAROSLAVSKY: I HAVE A REQUEST TO ASK HER. WOULD YOU RESPOND? 

LESLIE GILBERT-LURIE: THANK YOU, SUPERVISOR YAROSLAVSKY. I WOULD SAY THAT WE HAVE NO DISAGREEMENT WITH YOU ON ANYTHING THAT YOU SAID. WE WEREN'T HERE TODAY TO ADVOCATE FURTHER FOR AN EXECUTIVE DIRECTOR. WE'VE BEEN GIVEN THE HELP WE NEED IN FINDING ONE. AND WE WERE VERY CLEAR WITH THE SEARCH FIRM THAT WE WANT TO DO NOTHING TO GET IN THE WAY OF SLOWING DOWN THE SEARCH. AS I SAID WE WANT TO BE SUPPORTIVE OF THE PROCESS AND BE HELPFUL IN THE PROCESS. AND TO ANSWER YOUR QUESTIONS, JUST TO EXPAND FOR ONE SENTENCE, SUPERVISOR ANTONOVICH, WE DO SEE US AS ONLY REALLY HAVING TWO ROLES. ONE IS BEING HERE UNTIL THAT DIRECTOR IS HIRED AND HELPING TO STRUCTURE THE OFFICE IN THE MEANTIME AND SEEING THAT AS MANY RECOMMENDATIONS CAN BE IMPLEMENTED AS ARE ABLE TO BE IMPLEMENTED BEFORE THAT OFFICE IS IN PLACE. WE LOOK FORWARD TO BEING OUT OF BUSINESS. AND WE HOPE YOU HIRE THE DIRECTOR AS SOON AS POSSIBLE. THERE IS NOTHING THAT IS GOING TO COME OUT OF OUR TEAM THAT IS GOING TO SLOW DOWN THE PROCESS. 

SUP. YAROSLAVSKY: THANK YOU. 

SUP. KNABE, CHAIRMAN: JUST TO MAKE SURE THAT IT'S AN ADVISORY ROLE. I JUST WANT TO MAKE SURE OF THAT. YES, SUPERVISOR RIDLEY-THOMAS? NO, I WAS JUST COMMENTING ABOUT THERE'S NO CONFLICT. BUT I WANT TO MAKE -- THERE'S A LOT OF "WE WANT" AND "WE WANT THAT" AND I AM JUST CONCERNED THAT WE MAINTAIN THAT ADVISORY RELATIONSHIP AND THAT THE BOARD IS ULTIMATELY GOING TO BE RESPONSIBLE FOR THAT DECISION. YES? 

SUP. RIDLEY-THOMAS: LET ME JUST SIMPLY OFFER A COUPLE OF INSIGHTS, MR. CHAIRMAN AND COLLEAGUES. FIRST OF WHICH IS THAT THE TRANSITION TEAMS PERIODIC REPORTS TO US SHOULD CONTINUE SO THAT WE CAN HAVE THE KIND OF OPEN DIALOGUE AND EXCHANGES BEING EVIDENCED TODAY IN THAT CONTEXT, I BELIEVE THAT WE CAN CLARIFY WHAT PROGRESS MEANS. AND HOW WE CAN REALLY REINFORCE THE COMMITMENT THAT EACH MEMBER OF THE BOARD HAS MADE, EACH MEMBER OF THE BLUE RIBBON COMMITTEE DID MAKE, AND WHAT THE TRANSITION TEAM SEEKS TO DO. IT ONLY TAKES A LOOK AT THE NEWSPAPER TODAY AND THE RECOUNTING OF THE GRAND JURY INVESTIGATION REGARDING GABRIEL FERNANDEZ TO REMIND US SEARING TERMS WHILE WE MUST DO WHAT WE ARE DOING. AND WHY IN FACT PROTECTION OF THE VULNERABLE, AT RISK YOUNGSTERS IN OUR COUNTY REQUIRES ALL THAT WE CAN GIVE IT, STRUCTURALLY, SYSTEMICALLY, MORALLY. LEGALLY. IT ONLY TAKES A REVIEW OF THAT ARTICLE. IF YOU HAVEN'T READ IT, MAY I SIMPLY COMMEND IT TO YOU. I THINK THE TRANSITION TEAM AND ITS MEMBERS SEEK TO ADD VALUE TO THAT VERY PROPOSITION. I BELIEVE THAT THE MEMBERS OF THE BOARD UNDERSTAND THAT THERE IS WORK TO BE DONE AND WE CAN ULTIMATELY ARRIVE AT THE SAME PLACE. GET ON THE SAME PAGE. IT WAS THE DECISION OF THE BOARD TO MOVE FORWARD WITH THE OFFICE OF CHILD PROTECTION. SOME THINGS WERE CLEAR AND ARE OBVIOUS, SOME THINGS WERE NOT. BUT WE NEED TO KEEP MOVING FORWARD AN AGENDA THAT GETS US WHERE WE NEED TO BE. THE BUSINESS OF THE MEDICAL HUBS, ANOTHER PRIORITY, WE NEED TO GET TO THAT TASK. IT IS NOT REDUCIBLE TO THE SELECTION THE PERSON WHO WILL LEAD THE OFFICE ALONE. THERE ARE MANY OTHER THINGS, I WOULD HOPE, THAT WOULD COME BACK TO THE BOARD PURSUANT TO YOUR DELIBERATIONS TO SUGGEST WHAT PROGRESS LOOKS LIKE. IN OTHER WORDS. MAY I SIMPLY REQUEST NOT TO GET STUCK EXCLUSIVELY ON THIS ELECTION OF THE LEAD PERSON FOR THE OFFICE OF CHILD PROTECTION TO CAPTURE THE SPIRIT AND INTENT OF THE BLUE RIBBON COMMISSION AND THE PRIORITIES THAT WERE SET FORTH BY WAY OF RECOMMENDATIONS FOR THE PURPOSE OF KEEPING THIS AGENDA MOVING FORWARD IN CONSULTATION, IN CONCERT WITH MEMBERS OF THE BOARD. I REPEAT. IT ONLY TAKES US TO BE REMINDED BY WAY OF THAT ARTICLE IN THE PAPER TODAY AS TO WHY WE MUST STAY LASER LIKE FOCUSED ON THE BUSINESS OF CHILD PROTECTION AS OUR SINGLE MOST PRIORITY. TO GET DISTRACTED IN ANY OTHER WAY ULTIMATELY IS A DISSERVICE TO THE TOTAL AGENDA. AND IT WILL CONTRADICT THE GOOD WORK, THE QUALITY WORK, THE HARD WORK THAT WAS DONE BY THE BLUE RIBBON COMMISSION AND THAT WHICH IS BEING TAKEN FORWARD BY THE TRANSITION TEAM IN COOPERATION, IN CONSULTATION OF THE BOARD OF SUPERVISORS. MR. CHAIRMAN? 

SUP. KNABE, CHAIRMAN: ANY FURTHER COMMENT? IF NOT, THANK YOU ALL VERY MUCH. WE LOOK FORWARD TO THE NEXT REPORT. THANK YOU. ALL RIGHT. OH. AND WE HAVE SOME PUBLIC COMMENT AFTER -- DR. GENEVIEVE CLAVREUL. ERIC PREVEN? AND ARNOLD SACHS. 

ERIC PREVEN: OKAY. ITS ERIC PREVEN, COUNTY RESIDENT FROM DISTRICT 3. AND I CONCUR WITH MARK RIDLEY-THOMAS WHO HAS STEPPED OUT, I GUESS, THAT IT'S VERY IMPORTANT THAT THE FOCUS REMAIN FIXED ON THE JOB AT HAND. MAYOR -- I MEAN SUPERVISOR YAROSLAVSKY REMEMBERS, I BELIEVE, THAT WE HIRED A FIRM LIKE MR. OPPENHEIM TO LOOK FOR THE OFFICE OF INSPECTOR GENERAL AND IT WENT ON AND ON AND ON. AND NOW SUDDENLY FOR THE COMMISSION THAT HE WAS NOT INTERESTED IN, HE WANTS TO GET THIS THING DONE BEFORE HE LEAVES OFFICE. NOW, I AGREE WITH HIM, OF COURSE. BUT I JUST POINT THAT OUT. AND SUPERVISOR MOLINA'S NOT HERE TODAY. I WOULD SAY THAT THE BLUE RIBBON COMMISSION SHOULD HAVE, AND I URGE THEM TO MAKE SOME RECOMMENDATIONS OF NAMES, THE IDEA THAT THESE NAMES AS ALISA B. KATZ ONCE TOLD ME ABOUT OFFICE OF INSPECTOR GENERAL FOR THE SHERIFF'S OVERSIGHT GROUP NEEDS TO BE STRICTLY CONFIDENTIAL IS FLATLY ABSURD. WE'RE LOOKING FOR A VERY PUBLIC ROLE HERE. SOMEBODY WHO WILL TAKE AN ACTIVE TASK OF INTEGRATING DEPARTMENTS THAT ARE NOT EXCITED ABOUT SHARING THEIR RESOURCES UNFORTUNATELY. THEY WANT TO GET TO THE SAME GOAL BUT THEY DON'T WANT TO SHARE THEIR RESOURCES. SO WE REALLY NEEDED A BIG LARGER THAN LIFE CHARACTER, A GUY LIKE AUSTIN HOWEVER YOU SAY HIS NAME, BUTNER, WHO MOVED ON TO BE THE HEAD OF THE L.A. TIMES SURPRISINGLY. OR WHAT ABOUT SOME OF THESE CHARACTERS. LIKE IF SHEILA KUEHL OR BOBBY SCHRIVER LOSES, WHAT ABOUT A CHARACTER LIKE THAT? WOULD THAT BE THE KIND OF RIGHT PERSON, PUTTING NAMES INTO THE MIX? BOBBY SCHRIVER LIKES TO SHAKE THINGS UP. SHEILA KUEHL CERTAINLY HAS NINE LIVES OR WANTS NINE LIVES. I MEAN WHOEVER LOSES COULD BE A CANDIDATE OR MAYBE WE CAN'T WAIT THAT LONG. WHAT ABOUT SOMEONE LIKE ALEX JOHNSON WHO IS A WORK IN EDUCATION BUT ALSO LAW ENFORCEMENT AND IS A CERTAINLY AN UP AND RISING STAR IN THE LOCAL GOVERNMENT. I MEAN SOMEBODY NEEDS TO BE MAKING SOME SPECIFIC RECOMMENDATIONS. AND THE FACT THAT WE HAVE BEEN CIRCLING AROUND AND SEEING THE VARIOUS TENTACLES OF MISS HAMAI AND MR. FUJIOKA WONDERING WHICH EXECUTIVE DIRECTOR TO PUT ON THE PAYROLL HERE, I DON'T THINK WE NEED ANOTHER PIECE OF PAYROLL. I THINK WHAT WE NEED IS THIS BOARD OF SUPERVISORS TO LOOK INTO THE COMMUNITY THAT THEY'VE BEEN LOOKING AT AND BY THE WAY, JUST TO BE VERY CLEAR, WE'RE ALSO LOOKING FOR ANOTHER COUNTY COUNSEL, A NEW C.E.O., A NEW DIRECTOR OF PUBLIC HEALTH, A NEW AUDITOR-CONTROLLER. SO THEY'RE JUMPING OFF THE SHIP AND WE NEED TO FIND SOMEBODY TO HELP THESE CHILDREN. 

SUP. KNABE, CHAIRMAN: I DON'T THINK YOU CAN CALL JUMPING OFF THE SHIP 40 YEARS OF SERVICE. YOU KNOW, JUST, YOU KNOW, YOU GOT TO TELL THE TRUTH SOMETIMES. 

ERIC PREVEN: I ALWAYS TELL THE TRUTH, SIR. JOHN KRATTLI RETIRED LIKE THAT. AND NOW HIS GUY SITTING THERE I WOULD NOT CALL TRANSITION. 

SUP. KNABE, CHAIRMAN: 38 YEARS, THAT'S NOT BAD. 

ERIC PREVEN: WHY DO YOU DO IT LIKE THAT? 

SUP. KNABE, CHAIRMAN: THAT'S HIS CHOICE. 

ERIC PREVEN: AND WHY DID YOU DO IT LIKE THAT? THE WAY YOU DO IT PROPERLY IS YOU REPLACE YOURSELF WITH SOMEONE WHO IS GREAT FOR THE JOB. YOU DON'T WAIT SO THAT THERE'S A SIX-MONTH GAP. 

SUP. KNABE, CHAIRMAN: I FORGOT TO ASK YOU, I'M SORRY. 

ERIC PREVEN: OR LIKE THE OFFICE OF INSPECTOR GENERAL, A TWO-YEAR GAP FROM THE BRILLIANT C.C.J.V. WHICH HAD REPETITIVE RECOMMENDATIONS AND HAS RESULTED IN A BRAND NEW JAIL TO BE BROUGHT YOU BY A.E.C.O.M. I'M UPSET BECAUSE I WANT -- 

SUP. KNABE, CHAIRMAN: THANK YOU, NEXT. 

ARNOLD SACHS: YES, THANK YOU. GOOD AFTERNOON. GOOD MORNING, ARNOLD SACHS. QUITE A PRESENTATION. YOUR REFERENCE, SUPERVISOR YAROSLAVSKY ABOUT THE SHAPE OF THE TABLE WHILE THE WAR IS GOING ON IS AN OVERVIEW OF THE VIETNAM WAR. WHICH SIDE WERE YOU ON? FIRST YOU TAKE THE SIDE OF SHAPING THE TABLE. THEN YOU TAKE THE SIDE OF PEACE NEGOTIATIONS. WHICH SIDE ARE YOU ON? YOU HEARD A COUPLE DIFFERENT WAYS. THE MOST DIFFICULT SITUATION FOR THIS IS: DIFFERENT DEPARTMENTS WORK TOGETHER. SOUNDS LIKE THOSE OLD SILOS. THAT'S YOU? THAT'S YOUR DOING. DON'T YOU HAVE OVERSIGHT OF D.C.F.S. FOR THE LAST TWO YEARS? YOU TOOK IT AWAY FROM THE C.E.O. HOW CAN THERE BE SILOS WHEN THE DISTINGUISHED, OH MY GOD, BOARD OF SUPERVISORS IS IN CHARGE OF APPOINTING THE CHAIR PEOPLE FOR THESE DEPARTMENTS? OH, AND WHILE D.C.F.S., WHILE THE BLUE RIBBON COMMISSION IS DOING THEIR CHILD PROTECTION PRESENTATION, THE D.C.F.S. HAS A STRATEGIC PLAN WITH ITS PRESENTATION FROM JUNE 4TH. AND ITS INITIATIVES. SO HOW DO THOSE INITIATIVES FILL IN WITH THE BLUE RIBBON COMMISSION'S PLAN FOR THE CHAIRPERSON? HOW DOES HE DEAL WITH THOSE? AND THEN WE HAD A PROBLEM WITH FUNDING. REMEMBER THE FUNDING. BUT YOU HAVE THE FUNDS FOR THE INITIATIVES. YOU JUST DON'T HAVE FUNDS FOR THE BLUE RIBBON COMMISSION RECOMMENDATIONS. AND WHAT ARE THE DIFFERENCES BETWEEN THE RECOMMENDATIONS AND THE INITIATIVES? WELL WE DON'T KNOW. IT'S BOARD GIBBERISH. THEY WANT A DIRECTOR TO BE EXTRAORDINARY. YOU HAVE TO BE EXTRAORDINARY TO WADE THROUGH ALL THE CRAP THAT'S COME FROM THIS BOARD OF SUPERVISORS. YOU HAVE TO BE SUPER EXTRAORDINARY. YOU HAVE TO HAVE WADERS UP TO YOUR EARS. THEN THE PART WHERE SOMEBODY SAID THE OFFICE NEEDS TO BE FILLED BEFORE THE RECOMMENDATIONS ARE ADDRESSED. THEN WE JUST HEARD THAT THE COMMISSION IS ADDRESSING RECOMMENDATIONS. SO WHICH IS IT? DOES THE COMMISSION ADDRESS RECOMMENDATIONS WHILE THEY'RE ALSO LOOKING FOR THE DIRECTOR? OR DO WE WAIT FOR THE DIRECTOR WITH THE RECOMMENDATIONS WHILE THE INITIATIVES ARE BEING FILLED? WHICH IS IT? WHATEVER WE SAY IT IS. IT'S OUR CALENDAR. BY THE WAY, DOES AUGUST HAVE 46 DAYS OR 47 DAYS? BECAUSE BUS PASSES ARE GOING UP IN SEPTEMBER. 

SUP. KNABE, CHAIRMAN: THANK YOU. ALL RIGHT. IT'S A RECEIVE AND FILE ITEM. ALL RIGHT. 42-B. IT'S YOURS, MIKE. DID SOMEONE HOLD IT? JOSEPH ASAVI, ALBERT DABADU, FATHER GEORGE BATRASHILL. OKAY. IDENTIFY YOURSELF AND THEN YOU CAN BEGIN YOUR TESTIMONY. 

GEORGE BETRASHO: HONORABLE AND ESTEEMED MEMBERS OF THE BOARD OF COUNTY SUPERVISORS. I AM CORE BISHOP GEORGE BETRASHO REPRESENTING THOUSANDS OF SYRIAN AMERICANS, RESIDENTS OF THE LOS ANGELES COUNTY. I'M HERE TO THANK YOU, ALL OF YOU, HONORABLE MEN AND WOMEN ESPECIALLY THE HONORABLE SUPERVISOR ANTONOVICH. I THANK YOU ON BEHALF OF HIS HOLINESS (INAUDIBLE) THE FOURTH (INAUDIBLE) PATRIARCH, THE UNIVERSAL FATHER OF THE ASSYRIAN CHURCH OF THE EAST AND THOUSANDS OF ASSYRIAN AMERICAN RESIDENTS OF THIS COUNTY AND MOST OF ALL I'D LIKE TO THANK YOU ON BEHALF OF THEIR BROTHERS AND SISTERS. THE ASSYRIANS OF IRAQ, WHO HAVE BEEN THE SUBJECT OF PERSECUTION, ATROCITIES, RAPE, BEHEADINGS AND EXPULSIONS. TODAY WITH THIS MOTION, YOU HAVE TAKEN A STAND ON THE SIDE OF JUSTICE. YOU HAVE BECOME A VOICE FOR THE VOICELESS. YOU HAVE SHOWN KINDNESS AND COMPASSION FOR THOSE SUFFERING. WE MUST NEVER FORGET WHAT EDMOND BURKE ONCE SAID. "ALL IT TAKES FOR EVIL TO PREVAIL IS THAT GOOD MEN TO DO NOTHING." 

SUP. KNABE, CHAIRMAN: THANK YOU. NEXT? 

ALBERT DAVIDOO: GOOD MORNING MY NAME IS ALBERT DAVIDOO, MR. CHAIRMAN, HONORABLE BOARD OF SUPERVISORS, TODAY WE GATHER HERE IN DEMOCRATIC FASHION SPEAKING ABOUT THE NATION WHICH CREATED DEMOCRACY ITSELF. IT PAINS ME THAT SIT AND WATCH OUR GRANDFATHERS' CIVILIZATION, ALL OF OURS, NOT JUST SYRIANS, BEING SLAUGHTERED BY THE HANDS OF THE LOST. THAT THIS DISENFRANCHISED MEMBERS OF CIVILIZATION TO ALLOW ISIS OR ANY GROUP FOR THAT MATTER TO SYSTEMATICALLY SLAUGHTER A SECT OF PEOPLE DUE SIMPLY TO THEIR BELIEFS IS GENOCIDE. THE 1915 ARMENIAN-ASSYRIAN-GREEK GENOCIDE ONCE AGAIN RIGHT BEFORE OUR VERY EYES. SINCE WORLD WAR II THE GREAT JEWISH BROTHERS AND SISTERS HAVE LOVED NO MORE. TODAY WE STAND UNITED. IN ALSO DECLARING NO MORE. WE CANNOT WAIT A MOMENT LONGER. WITH EACH MOMENT AN INNOCENT LIFE IS TAKEN. AND ANOTHER AND ANOTHER. I HEAR THE CRIES OF FRIGHTENED CHILDREN SLOWLY ACCEPT THEIR FATE. I WAKE UP FROM THIS NIGHTMARE NIGHT AFTER NIGHT AND EACH MORNING I REALIZE I LIVE IT. ONCE AGAIN WE HAVE AN INCUMBENT DUTY TO PRESERVE THE MOTHER OF CIVILIZATION AS IT WAS OUR CRADLED AND NURSED OUR GREATEST NATIONS ONE BY ONE TO POWER. I THANK YOU FOR ALL YOU DO. GOD BLESS YOU. GOD BLESS UNITED STATES OF AMERICA. 

SUP. KNABE, CHAIRMAN: THANK YOU. NEXT? 

SPEAKER: NONORABLE CHAIRMAN, HONORABLE BOARD OF SUPERVISORS, ESPECIALLY THANKS TO SUPERVISOR MICHAEL ANTONOVICH FOR INTRODUCING THIS MOTION, THIS RESOLUTION. I WOULD JUST SAY I'D LIKE TO THANK YOU ON BEHALF OF THE FOLLOWING ORGANIZATIONS THAT HAVE LEANT THEIR VOICE. THE SYRIAN AMERICAN ASSOCIATION OF SOUTHERN CALIFORNIA. ASSYRIAN CHURCH OF THE EAST. ASSYRIAN MEDICAL SOCIETY. ASSYRIAN DEMOCRATIC MOVEMENT. ASSYRIAN ASSEMBLIES OF GOD. ASSYRIAN AID SOCIETY. ANCIENT CHURCH OF THE EAST. SAFE FOR CENTER U.S.A., CHURCH OF (INAUDIBLE) ST. PAUL (INAUDIBLE) ASSYRIAN AND ST. PAUL ASSYRIAN CHURCH OF THE EAST. ASSYRIAN CHURCH OF THE EAST RELIEF ORGANIZATION AND ASSYRIAN MESOPOTAMIAN ORGANIZATION. AGAIN WE THANK YOU FOR THIS RESOLUTION AND WE HAVE ASK YOU TO VOTE YES ON IT. THANK YOU. 

SUP. KNABE, CHAIRMAN: MOVED BY SUPERVISOR ANTONOVICH. THE CHAIR WILL SECOND WITH ONE ABSTENTION NOTED. SUPERVISOR RIDLEY-THOMAS, SO ORDERED. WE WILL DO ADJOURNMENTS. I BELIEVE SUPERVISOR RIDLEY-THOMAS IS UP FIRST. SUPERVISOR YAROSLAVSKY, DO YOU HAVE ANY ADJOURNMENTS? 

SUP. YAROSLAVSKY: THANK YOU MR. CHAIRMAN. I HAVE TWO. FIRST I ASK THAT WE ADJOURN IN THE MEMORY OF JOHN BROOKS, A LONG TIME MEMBER OF THE COUNTRY FAMILY WHO WORKED FOR MORE THAN 20 YEARS FOR THE PARK POLICE DEPARTMENT WHO RECENTLY PASSED AWAY. HE FOUNDED THE SAN FERNANDO POLICE DEPARTMENT RESERVE UNIT WITH TWO OTHER OFFICERS AND HIS 50 YEARS OF SERVICE AS A RESERVE POLICE OFFICER WITH THE SAN FERNANDO POLICE. INCLUDED A RANGE MASTER AND WITH THE RANK OF SERGEANT. HE RETIRED IN 1992 WITH THE RANK OF LIETENANT. HE IS SURVIVED BY HIS WIFE ARLENE, TWO SONS, MICHAEL AND PATRICK, TWO DAUGHTERS, ANDREA RYNDERS AND MARETT JOHNSON, A SISTER MARY KENYON AND TWO GRAND DAUGHTERS AND ONE GREAT GRANDSON ALSO ASK THAT WE ADJOURN IN MEMORY OF LEONARD FEIN. A LONG TIME LEADER IN THE JEWISH COMMUNITY NATIONALLY AND INTERNATIONALLY, AN ACTIVIST, A WRITER, A SCHOLAR WHO RECENTLY PASSED AWAY AT THE AGE OF 80. HE GREW UP IN THE LABOR ZIONIST YOUTH MOVEMENT WHICH HELPED INSPIRE HIS LIFELONG DEDICATION TO INTELLECTUAL ATTAINMENT, PROGRESSIVE RELIGIOUS AND POLITICAL ACTIVISM AND SOCIAL JUSTICE. HE WENT ON TO BECOME A PROFESSOR AND TEACHER AT BRANDEIS UNIVERSITY, HARVARD AND M.I.T. AND COFOUNDED "MOMENT" MAGAZINE WITH HOLOCAUST AUTHOR AND SURVIVOR ELIE WIESEL. HE ALSO FOUNDED MAZONE, A JEWISH RESPONSE TO HUGER, A HIGHLY SUCCESSFUL FOOD DRIVE FOR THOSE IN NEED INVOLVING JEWISH COMMUNITIES AROUND THE WORLD. THE NATIONAL JEWISH COALITION FOR LITERACY. AND HELPED FOUND AND SERVED ON THE BOARD OF AMERICANS FOR PEACE NOW, SUPPORTING THE ISRAELI PEACE MOVEMENT. AMONG HIS MANY BOOKS ARE: "WHERE ARE WE? THE INTER LIFE OF THE AMERICAN JEWS", AND "AGAINST THE DYING OF THE LIGHT." A MEMOIR OF THE DAUGHTER HE LOST TO AN UNEXPECTED HEART ATTACK WHEN SHE WAS ONLY 30 YEARS OLD. ALSO WROTE HUNDREDS OF ARTICLES ESSAYS AND OP-ED PIECES OVER THE YEARS AND CONTINUED WRITING A REGULAR COLUMN FOR THE FORWARD NEWSPAPER UNTIL HE PASSED AWAY. HE LEFT A RICH LEGACY AS AN INSPIRATION AND ROLE MODEL FOR GENERATIONS OF PROGRESSIVE JEWISH ACTIVISTS, MYSELF INCLUDED. HE WAS A MENTOR TO ME WHEN I WAS A COLLEGE STUDENT. HE TRAVELED OUT HERE ALL THE TIME. AND HE WAS A PERSON WHO WAS A MAGNET FOR PEOPLE WHO WERE LOOKING FOR EXAMPLES TO FOLLOW. HE WILL TRULY BE MISSED. HE'S SURVIVED BY FAMILY MEMBERS, COLLEAGUES AND A WHOLE LOT OF FRIENDS. THOSE ARE MY ADJOURNING MOTIONS. 

SUP. KNABE, CHAIRMAN: SO ORDERED. I HAVE A COUPLE ADJOURNMENTS. FIRST OF ALL THAT WE ADJOURN IN MEMORY OF LIEUTENANT PATRICK LIBERTONE FROM THE FRAUD AND CYBERCRIMES BUREAU OF THE LOS ANGELES COUNTY SHERIFFS. HE PASSED AWAY SUDDENLY ON AUGUST 12TH WHILE ON DUTY. PATRICK BEGAN HIS CAREER AT THE SHERIFF'S DEPARTMENT IN 1983 ASSIGNED AT MEN'S CENTRAL JAIL. HE ROSE UP THE RANKS FROM PATROL DEPUTY AT TEMPLE STATION TO SERGEANT NORWALK AND LIEUTENANT AT FRAUD AND CYBERCRIMES. AMONG OTHER VARIOUS PROMOTIONS HE RECEIVED. HE RECEIVED OVER 75 COMMENDATIONS AND AWARDS FOR HIS EXEMPLARY SERVICE. HE WAS KNOWN AS A HUMBLE AND HAPPY MAN WHO ALWAYS WORE A SMILE AND GO ABOVE AND BEYOND THE CALL OF DUTY FOR HIS COWORKERS AND FRIENDS. HE LOVED SCUBA DIVING AND TRAVEL. HE IS SURVIVED BY WIFE SHERISE, HIS FOUR CHILDREN, BRIAN, JANELLE, HAILEY AND RACHEL AS WELL AS VARIOUS FAMILY FRIENDS AND COLLEAGUES. HE WILL BE TRULY MISSED BY ALL THOSE LIVES HE TOUCHED AND HIS SERVICE WILL NOT BE FORGOTTEN. AND THEN WE JOIN IN MEMORY OF MICHAEL SIMMONS WHO PASSED AWAY AFTER A LONG STRUGGLE WITH LUNG CANCER AT THE AGE OF 63. LIFELONG RESIDENT OF LONG BEACH. A RECENT RETIREE OF THE OPERATING ENGINEERS UNION. SURVIVED BY HIS BROTHERS. DICKIE WHO WORKS FOR ME AND BRADLEY AND NUMEROUS NIECES AND NEPHEWS. THOSE ARE MY ADJOURNMENTS. MICHAEL? 

SUP. ANTONOVICH: AND THE I'D LIKE TO MOVE IN THE MEMORY OF SUZANNE FETTERS A FORMER COMMISSIONER OF MINE WHO PASSED AWAY ON AUGUST 16TH, A GRADUATE OF CAL STATE UNIVERSITY LOS ANGELES. HER HUSBAND LARRY FETTERS WAS A LOS ANGELES POLICE DEPARTMENT FOR 31 YEARS RETIRING AS DEPUTY CHIEF AND WENT ON TO BECOME SECURITY DIRECTOR OF THE HOMELAND SECURITY AT L.A.X. FOR EIGHT YEARS. AND SHE ALSO SERVED ON THE MEESE COMMISSION, THE FEDERAL COMMISSION ON PORNOGRAPHY WHEN ATTORNEY GENERAL MEESE ORDERED IT. SHE'S SURVIVED BY HER HUSBAND LARRY, THEIR TWO CHILDREN, PATTY AND JOHN AND THEIR FOUR SIBLINGS AND SHE WAS QUITE INVOLVED IN THE SAN GABRIEL VALLEY AND PUNTINGTON SQUARE ISSUES AND A REAL GOOD FRIEND. CONNIE WORDEN-ROBERTS. 

SUP. KNABE, CHAIRMAN: ALL MEMBERS. 

SUP. ANONOVICH: CONNIE WORDEN-ROBERTS LONG TIME RESIDENT OF SANTA CLARITA PASSED AWAY AT THE AGE OF 83. SHE WAS A SPECIAL ASSISTANT TO THE PRESIDENT OF H.R. TECHSTRON AND ASSEMBLYWOMAN MARIAN LA FOLETTE. SHE WAS A DEDICATED ENTHUSIASTIC MEMBER OF THE SANTA CLARITA VALLEY COMMUNITY. AS MY APPOINTEE TO THE NORTH COUNTY TRANSPORTATION COALITION, SHE PROVIDED A PASSIONATE VISION FOR IMPROVED TRANSIT SERVICE. HER LEADERSHIP CONTRIBUTED TO A TRANSPORTATION PLAN AND NEW ROADS THAT BECAME THE BACKBONE OF OUR VALLEY. SHE CHAIRED THE SANTA CLARITA VALLEY TRANSPORTATION ALLIANCE CONTRIBUTED TO THE CONSTRUCTION OF THE CROSS VALLEY CONNECTOR, SERVED ON SEVERAL BOARDS AND COMMITTEES INCLUDING THE SANTA CLARITA VALLEY'S CITY'S PLANNING COMMISSION AND THE FRIENDS OF HART PARK, WHITTAKER VERMIGHT CITIZENS ADVISORY GROUP AND THE SANTA CLARITA PARADE COMMITTEE. SHE HAD A COMMITMENT TO THE RESIDENTS OF THE VALLEY IN THE FIFTH DISTRICT AND SHE IS SURVIVED BY HER SON LEON. RALPH WALROTH PASSED AWAY AT THE AGE OF 98. HE WAS AN ACTIVE MEMBER WITH THE Y.M.C.A., JUNIOR CHAMBER OF COMMERCE AND THE FIRST PRESBYTERIAN CHURCH OF BURBANK. HE PASSED AWAY, AS I SAID, AT THE AGE OF 98. WHAT'S INTERESTING ABOUT RALPH, HE WORKED WITH LOCKHEED AIRCRAFT FOR 41 YEARS AND THEN WENT TO WORK PART-TIME FOR THE GLENDALE LIBRARY. AND HE WAS THE OLDEST EMPLOYEE AT THE CITY OF GLENDALE WORKING IN THE LIBRARY FOR 31 YEARS UNTIL HE PASSED ON. AND HE IS SURVIVED BY HIS FOUR CHILDREN. LUCILLE LOU SMITH LONG TIME RESIDENT SANTA CLARITA. NUTRITIONIST AT PINE CREST ELEMENTARY FOR 25 YEARS AND A MEMBER OF THE GRACE COMMUNITY CHURCH FOR MANY YEARS. SURVIVED BY HER TWO SONS. THEODULE DELANO MARTIN, LONG TIME RESIDENT OF ANTELOPE VALLEY PASSED AWAY AT THE AGE OF 96. HE WAS A WORLD WAR II VETERAN AND HIGH SCHOOL AND VICE PRINCIPAL FOR 35 YEARS AND ACTIVE IN THE GAY COMMUNITY CHURCH. HE'S SURVIVED BY HIS WIFE OF 68 YEARS, ESSIE. KEITH DWANE MCPEEK, LONG TIME RESIDENT OF LANCASTER PASSED AWAY AT THE AGE OF 78, SERVED IN THE UNITED STATES MARINE CORPS DURING THE KOREAN WAR, HAD A 50-YEAR CAREER AS A MORTUARY PROFESSIONAL AND 40-YEAR MEMBER OF SACRED HEART CHURCH AND SERVED THE COMMUNITY WITH THE KNIGHTS OF COLUMBUS. CHESTER POLEK, RETIRED DEPUTY MARSHAL WITH THE LOS ANGELES COUNTY. HIS LAST ASSIGNMENT WAS EL MONTE COURT. JEFFREY SHROUT, RETIRED DEPUTY WITH THE LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. HIS LAST ASSIGNMENT WAS WITH THE WEST HOLLYWOOD STATION. MARCUS BENEVIDEZ. LONG TIME RESIDENT OF SANTA CLARITA. TRAGICALLY PASSED AWAY AT THE AGE OF 29. HE ATTENDED SAUGUS HIGH SCHOOL AND WAS A GRAPHIC ARTIST ASSISTANT FOR IMPORT COLLECTION FOR THE PAST EIGHT YEARS. BRAD ANTHONY COSGROVE. LONG TIME RESIDENT OF LANCASTER. PASSED AWAY AT THE AGE OF 60. HE WAS A GRADUATE OF C.S.U.N. AND HAD A 35-YEAR CAREER AS AN ACCOUNTANT. SERVED FOR OVER 30 YEARS AS A MEMBER OF THE ANTELOPE VALLEY KIWANIS. SERGEANT KENT NEBERGALL PASSED AWAY ON AUGUST 12TH AT THE AGE OF 67. HAD SERVED IN THE VIETNAM WITH THE UNITED STATES ARMY. HE WAS A CREW CHIEF ON THE 189TH U.S. ARMY ASSAULT HELICOPTERS. HE WAS A SUCCESSFUL RECORDING ENGINEER AFTER THE WAR FOR SUNSET SOUND RECORDING STUDIO. TRAGICALLY, POPE FRANCIS'S GREAT NEPHEWS AND HIS NEPHEW'S MOTHER WERE TRAGICALLY KILLED TODAY EARLY THIS MORNING AND A FOURTH IS IN CRITICAL CONDITION AFTER AN AUTOMOBILE CRASH IN ARGENTINA. SO WE ADJOURN IN THEIR MEMORY. VALERIA CARMONA, JOSE CARMONA AND ANTONIO CARMONA. THOSE ARE MY ADJOURNMENTS. 

SUP. KNABE, CHAIRMAN: OKAY. PUBLIC COMMENTS? ROBERT LUCAS, IRENE PANG. ARNOLD SACHS, ERIC PREVEN. ALL RIGHT. BEFORE YOU GUYS START, EXCUSE ME. WE DO HAVE ONE -- TWO IN LANCASTER. SYLVIA BROWN AND CYNTHIA BEVERLY. LET'S GO TO LANCASTER FIRST. DON'T START. GO AHEAD AND START UP THERE, PLEASE. 

ROBERT LUCAS: HI, MY NAME -- 

SUP. KNABE, CHAIRMAN: EXCUSE ME. 

SYLVIA BROWN: HI, I'M SYLVIA BROWN. ACCORDING TO THE CALIFORNIA CODE OF REGULATIONS TITLE 22 SOCIAL SECURITY DIVISION 3 HEALTHCARE SERVICES SUBDIVISION 1 CALIFORNIA MEDICAL ASSISTANCE SECTION DEDUCTIONS FROM ANY INCOME OF ALL MEDICALLY NEEDY OR MEDICALLY INDIGENT PROGRAM. THE DEDUCTION IN SECTION 50551 THROUGH 50552 SHALL BE SUBTRACTED FROM ANY NONEXEMPT INCOME THAT REMAINS AFTER APPLICATION OF A LAW PROCEEDING EXEMPTIONS AND DEDUCTIONS. SECTION 50551 STATES INCOME OF A MEDICALLY NEEDED PERSON USED TO DETERMINE THE PUBLIC ASSISTANCE ELIGIBILITY OF ANOTHER FAMILY MEMBER, THAT PORTION OF THE INCOME OF THE MEDICALLY NEEDED PERSON OR MEDICALLY INDIGENT PERSON OR PERSON RESPONSIBLE FOR THE FAMILY MEDICAL BUDGET UNIT WHICH IS COUNTED AND DETERMINED THE ELIGIBILITY OF A SPOUSE, PARENT OR CHILD OF A PUBLIC ASSISTANCE OR RECIPIENT SHALL BE DEDUCTED. MY MOTHER APPLIED FOR MEDI-CAL IN APRIL OF 2013. I HAVE BEEN GIVING ALL YOUR REPRESENTATIVES THIS CODE. AND THEY REFUSE TO DEDUCT MY FATHER'S INCOME. THEY HAVE A HIGH SHARE OF COST OF $3,800 A MONTH AND WE APPLIED FOR IN-HOME HEALTH SERVICES. I AM THEIR PROVIDER. AND I AM NOT RECEIVING AN INCOME BECAUSE THEY'RE TELLING THEM THAT THEY HAVE TO PAY $3,800 IN SHERIFF'S COSTS. IF THAT INCOME IS DEDUCTED ACCORDING, IF MY FATHER'S INCOME IS DEDUCTED BECAUSE HE WAS ON THE APPLICATION AND WAS USED FOR THE MEDICAL FAMILY BUDGET UNIT, IF THEY GO AHEAD AND APPLY THIS CODE, THAT SHARE OF COSTS WILL BE DEDUCTED. AND I WILL BE ABLE TO PROVIDE THE SERVICES. I'M ALREADY BEEN PROVIDING SERVICES FOR OVER A YEAR NOW. BUT I WILL BE PAID WITH THE IN-HOME HEALTH SERVICES INSTEAD OF HAVING MY MOTHER, ALL THE MONEY, GETTING A NONNEGOTIABLE CHECK SAYING THAT THE RESPONSIBILITY IS ON MY PARENTS FOR THE SHARE OF COSTS. I'VE BEEN TALKING TO THE REPRESENTATIVES OF LOS ANGELES COUNTY. I HAVE SEVERAL HEARINGS. THEY KEEP TELLING ME TO GO TO THE HEARING. NOW THEY TRYING TO FORCE ME TO GO TO THE SUPERIOR COURT AND FILE A COURT. HOW CAN YOU SEND TWO PEOPLE AT THE AGE OF 88 IF YOU CAN'T FIND AN ATTORNEY TO FILE FOR THEIR RIGHTS AND THEIR BENEFITS UNDER THIS? THAT IS REALLY -- AND THEY ARE BOTH MEDICALLY NEEDY. THAT IS REALLY HARD AND PUTTING A LOT OF STRESS ON MY PARENTS AND ME, AS WELL, BECAUSE I'M GIVING THEM ALL THE SERVICES AND I'M NOT BEING PAID, WHICH THE INCOME SHOULD BE DEDUCTED IN THEIR SHERIFF'S COSTS. I'M ASKING YOU FOR YOU TO HAVE YOUR REPRESENTATIVES CALL ME BECAUSE THIS IS GOING COUNTYWIDE. 

SUP. KNABE, CHAIRMAN: SOMEBODY FROM SUPERVISOR ANTONOVICH'S OFFICE WILL BE IN CONTACT. NEXT? 

SYLVIA BROWN: I DIDN'T HEAR. 

SUP. KNABE, CHAIRMAN: I SAID THANK YOU FOR YOUR TESTIMONY. SOMEONE FROM SUPERVISOR ANTONOVICH'S OFFICE WILL BE IN CONTACT. THANK YOU. NEXT? FROM LANCASTER WE HAVE CYNTHIA BEVERLY? 

CYNTHIA BEVERLY: YES. MY NAME IS CYNTHIA BEVERLY. ACTUALLY I AM A CHILDREN'S RIGHTS ADVOCATE IN THE ANTELOPE VALLEY AWARE AS AN ACTIVIST. I COME HERE TO SPEAK ABOUT THE INJUSTICE OF THE COURT SYSTEM, THE JUSTICE SYSTEM. MY SON WAS ARRESTED, BOTH OF MY SONS WAS ARRESTED ON SEPTEMBER THE 12TH OF 2013. I HAVE FILED A COMPLAINT AGAINST THE DETECTIVE BY THE NAME OF KING. HE STATED TO ME, I ASKED HIM HIS NAME, HE STATED TO ME "HE'S DONE, HE'S DONE, I'M GOING TO STICK A FORK IN HIM, HE'S DONE." ON THIS CASE ON A BURGLARY CASE INSIDE A TORRANCE COURTHOUSE, MY YOUNGER SON HAD GOT A DEAL FOR TWO YEARS. MY OLDER SON THEY WANT HIM TO TAKE A DEAL FOR 20 YEARS. THEY SAID IF HE TAKE IT TO JURY TRIAL, THAT HE CAN GET 106 YEARS TO LIFE. NOW, HOW WHAT ABOUT THIS IS VERY CRUEL AND UNUSUAL PUNISHMENT THROUGH THE EIGHTH AMENDMENT. I, TOO, WAS ARRESTED BECAUSE I WAS A PART OF THE SECTION 8 LAWSUIT. I WAS A PART OF THE D.O.J. FINDINGS WITH THE SHERIFF'S DEPARTMENT IN THE ANTELOPE VALLEY. SO I WAS ARRESTED. AND THEY HAD SENT MY CASE DOWN TO NORWALK COURT. AND THE JUDGE STATED HE SAID, HE STATED, I CANNOT BELIEVE THE WAY THE PUBLIC FUNDS ABLE TO SPEND ON THIS CASE STARTING THE SHERIFF'S DEPARTMENT GOING DOWN TO THE DISTRICT'S ATTORNEY'S OFFICE AND COMING DOWN HERE TO THE JUSTICE SYSTEM, THE FACT THAT THIS CASE IS EVEN FILED BY THE DISTRICT ATTORNEY'S OFFICE IS AN EMBARRASSMENT, IT DOESN'T RISE TO THE LEVEL OF A CIVIL RESTRAINING ORDER, SO WE DO KNOW ABOUT THE INJUSTICE WITHIN THE COURT SYSTEM. IN TORRANCE COURTHOUSE IS ACTUALLY ANOTHER YOUNG MAN DURING ELECTION YEAR OF 2005, THIS YOUNG MAN GOT 205 YEARS TO LIFE FOR A BURGLARY CHARGE. MY SON IS LOOKING AT LIFE. 106 YEARS TO LIFE FOR A BURGLARY CHARGE, FOR NO WEAPONS INVOLVED AND NO ONE; AND NO PHYSICAL CONTACT WITH A PERSON. NOW, WE KNOW ABOUT THE JURY CAN HEAR ABOUT THE PRIORS BUT THEY DO NOT HEAR ABOUT HOW MUCH TIME THE PEOPLE IS GETTING WHEN THEY GET SENTENCED INSIDE THIS ROOM, INSIDE THE COURTROOM. I REACHED OUT TO THE DEPARTMENT OF JUSTICE. I REACHED OUT TO THE OMBUDSMAN'S OFFICE. I REACHED OUT TO THE BOARD OF SUPERVISORS. I SENT ALL THE BOARD OF SUPERVISORS EMAILS. I GOT HAILED TO TOWN HAIL MEETINGS HERE IN ANTELOPE JUSTICE FOR ALL FOR ALL, DO THE CRIMES FOR THE TIME. RIGHT NOW I AM REACHING OUT TO THE PASTORS, TO THE CHURCHES, TO THE PEOPLE OF THE ANTELOPE VALLEY, COMPTON, LONG BEACH, WATTS, TORRANCE, WHEREVER I HAVE TO GO. I WILL FIGHT FOR MY SON AND MANY OTHER PEOPLE THAT'S COMING TO ME WITH THE SAME PROBLEM AND THE SAME ISSUES. IF I GOT TO WALK THE STREETS UNTIL I GET BLISTERS ON MY FEET TO FIGHT FOR THE JUSTICE OF MY SON FOR HIS LIFE, I WILL DO SO. 

SUP. KNABE, CHAIRMAN: THANK YOU. 

CYNTHIA BEVERLY: THANK YOU. 

SUP. KNABE, CHAIRMAN: OKAY. GO AHEAD. MR. LUCAS AND MISS PANG. 

ROBERT LUCAS: MY NAME IS ROBERT LUCAS, YOU KNOW A LOT OF THE ISSUES I HEARD ARE VERY EMOTIONAL AND IMPORTANT. AND WHEN I HEARD THE CHILD ISSUE EARLIER, AND I REALLY TUNED IN AND LISTENED BECAUSE THIS IS A SUBJECT THAT'S REALLY CLOSE TO ME, IT SOUNDED LIKE A BUNCH OF INTELLIGENT PEOPLE IN RESPONSIBLE POSITIONS WERE ASKING FOR A REFEREE. THAT TELLS ME THAT THERE'S A LOT OF DRAMA GOING ON, EGOS, PRIDE, TITLES. SOMEBODY LOST SIGHT OF THE FACT THAT THE KIDS ARE THERE. BUT ALL THOSE DIFFERENCES ASIDE, YOU'RE WORKING IN THAT FIELD. IT'S A VERY IMPORTANT SUBJECT. LEAVE ALL THE DRAMA OUT. AND HANDLE AND GET THE ANSWERS THAT YOU NEED. IT SOUNDS LIKE THE CHILDREN THEY'RE PROTECTING, THEY'RE CRYING OUT. I NEED SOME HELP. THEY'RE ADULTS. THEY'RE EDUCATED. THEY'RE RESPONSIBLE. FIND THE ANSWERS FROM WITHIN YOURSELF AND STOP CREATING MORE OF A PROBLEM. I MEAN, I FELT SO COMPELLED TO DO THAT RIGHT NOW TO THE GOOD STUFF. I'M DOWN AT 6TH AND SAN PEDRO. I'VE BEEN GOING TO CITY COUNCIL. COUNTY SUPERVISORS FOR THE LAST MONTH. I'VE BEEN SO MOVED BY THE RESPONSE OF THE PEOPLE OF LOS ANGELES. I NEVER ANTICIPATED ANYTHING LIKE THIS HAPPENING. WITHIN TWO WEEKS OF THE CITY COUNCILMAN AND THE COUNTY SUPERVISORS, THE AREA OF 6TH AND SAN PEDRO, ST. JULIAN, CENTRAL L.A.P.D. HAS BEEN FLOODED WITH THE PUBLIC. I TRULY UNDERSTAND THE MEANING OF CITY OF ANGELS. THE FACT IS: SOME OF THE OVERWHELMING RESPONSE BY THE PEOPLE THAT WATCH WHAT GOES ON IN THIS BUILDING AND CITY HALL HAS JUST OVERWHELMED ME TO THE POINT THAT IT SHAKES ME WHEN I WALK THE STREETS. IT WARMS ME TO THE POINT THAT I KNOW THAT THERE ARE PEOPLE OUT THERE WHO CARE. THE FACT OF THE MATTER IS: A LOT OF THE PEOPLE DOWN THERE DON'T QUITE SEE IT. I PUT THE WORK IN EVERY DAY TO HELP THEM REALIZE IT. AND LET THE PEOPLE KNOW THAT COME DOWN THERE THAT I APPRECIATE THEM WITH THE EFFORTS. IT'S BEEN FROM EVERY DISTRICT, EVERY WALK OF LIFE. THE LOVE THAT IS GIVEN TO THE PEOPLE DOWN THERE THAT REALLY DON'T EVEN UNDERSTAND AND RECOGNIZE THAT THAT'S WHAT IT IS IS BESIDE THE POINT. I'M DOWN THERE WITH BOOTS ON THE GROUND TRYING TO HELP THESE PEOPLE REALIZE THE EMPATHY THAT PEOPLE FEEL FOR THEM. STOP TAKING ADVANTAGE OF THE RESOURCES THAT CAN VERY WELL HELP YOU BUILD THE REST OF YOUR LIFE. NEXT WEEK WHEN I COME IN, I HAVE A MISSION STATEMENT FOR YOU AND FOR ALL OF THE PEOPLE WHO WATCH THESE PROCEEDINGS AND ACTUALLY MOVED ON THIS, I NEVER ANTICIPATED. I GOT SOME STUFF I DON'T KNOW WHAT TO DO WITH SO I'M GOING TO SPEND THE REST OF THE AFTERNOON GIVING IT AWAY. 

SUP. KNABE, CHAIRMAN: THANK YOU. NEXT? MISS PANG? 

IRENE PANG: I'M IRENE. FROM THE I CONCERNED ABOUT FROM THE AUGUST 12 TO THE AUGUST 15TH 2014, BELOW THE FIELD CLASS THE CONSTRUCTION ON THE BUILDING LOCATED ON THE 11635 ON THE RED BLUE LINE EL MONTE, CALIFORNIA. THE 11635 -- ON THE AUGUST 12, AUGUST THE 13 OR AUGUST 18, 2014 AND CATCH THOSE PAGE NUMBER OF IN THE 12TH, AUGUST THE 12TH THE PAGE NUMBER IS THE ONE IS THE 353151 F1 TRUCK. AND SECOND ONE IS THE 74833 AND GMC VIN. AND THEN AUGUST 13 IS THE FIRST CAR IS THE 5 A45761 VIN AND THE SECOND CAR IS THE 8F1854. AND THE THIRD AND THE 18 THE CARS AGAIN THE 754-8344 GMC. AND THE OLD AGE CARS THEY HAD WRESTLING. AND THE PERSONS IDENTIFIED BY THE CAR LEAVE THE RESPONSE TO ALL THE DAMAGE OF THE BUILDING AND THE PARKING LOT. TO CLARIFY AND CONCERNED POSITION OF THE ECONOMY AND THE CITIZEN THE PATIENT MY FAMILY MEMBERS THE -- BY SAID NAME TO CLARIFY AND CONFIRM THE POSITION OF THE ECONOMY AND INFORMATION SYSTEM. THE PRESENT POSITION TO MY FAMILY MEMBER WHO HAD BEEN DONE THE PROGRESSING EQUIPMENT AND PROGRESS TO STAFF THE -- OF THE ECONOMY AND OF THE GOVERNMENT AND PROPERTY. NUMBER 5, SAFETY IS IMPORTANT TO MY FAMILY MEMBERS AND THE VICTIMS ARE NECESSARY. NUMBER 6, I DISAGREE THAT MAYBE SAYING THE PAY FOR THE REVELATION, THE INVESTIGATION BECAUSE THE REVELATION IS THE RACE UP BY THE REVELATION PERSON IS ALSO SOME IS THE GOVERNMENT BE NOT CATCH THEM. ALL THE JOB IS SOME KIND FELL ON DUTY. BECAUSE THE KIND OF REVELATION. AND INVESTIGATION ARE NECESSARY ALSO THE GOVERNMENT TO STOP IN THE FUTURE ON PRESENT TIME. THANK YOU. 

SUP. KNABE, CHAIRMAN: THANK YOU. NEXT? 

ERIC PREVEN: YES, IT IS ERIC PREVEN. ONE ADDITIONAL NAME FOR THE LIST OF POTENTIAL BLUE RIBBON COMMISSION DIRECTORS OR I GUESS, YEAH, THAT'S IT. HOW ABOUT JONATHAN FREEDMAN, F-R-E-E-D, THERE WAS A BROMANCE GOING ON THERE WITH SUPERVISOR YAROSLAVSKY AND THOSE GUYS. HE'S A VERY COMPETENT MAN. HOW ABOUT SOMEONE LIKE THAT WOULD BE ONE PITCH. I'M THROWING THEM OUT THERE BECAUSE I THINK WE NEED SOMEBODY AND URGENTLY. I'D ALSO LIKE TO ASK C.E.O. FUJIOKA WHO'S ENSCONCED IN A CONVERSATION NOW WITH SUPERVISOR YAROSLAVSKY ON ITEM 24 LAST, NOT LAST BUT THE PREVIOUS WEEK THERE WAS ACTUALLY AN ITEM THAT LOOKED AT THE A.E.C.O.M. PROVISION, WHAT THEY'RE GOING TO BE DOING IN PHASE 1 ON THIS BIG JAIL ROLLOUT. AND IN THAT DOCUMENT, THEY LISTED THE PEOPLE ON THEIR STAFF. IT WAS SORT OF A MEMO, SO YOU COULDN'T REALLY SEE IT UNLESS YOU WERE SNOOPING AROUND. BUT WHAT THEY OUTLINED WAS IF I UNDERSTOOD IT CORRECTLY, A COUPLE CHARACTERS WOULD BE HELPING OUT ON THE MENTAL HEALTH SIDE, THE JACKIE LACEY'S BEEN WORKING ON, THE DIVERSION PIECE, I GOT THE FEELING. AND IT WAS IDENTIFIED AS THE J.F.A. INC. WHICH I ALWAYS UNDERSTOOD TO BE THE JAMES AUSTIN GROUP. JAMES AUSTIN WAS THE GUY FOR THE REFERENCE WHO WROTE THE ROAD MAP AWAY FROM BUILDING A GIANT NEW JAIL. HAS ENGAGED TWO PEOPLE A GUY NAMED J. FARBSTEIN WHO I MENTIONED WROTE A BOOK IN 1986 ON JAILS. AND THEN ANOTHER WOMAN NAMED BRENDA EPPERLY WHO SURPRISINGLY WORKED IN MENTAL HEALTH AT C.D.C.R. WHO ARE FACING THEIR OWN MAJOR CRISES WITH THE FEDERAL GOVERNMENT ON THESE ISSUES. SO, MY QUESTION IS: IS IT THE SAME J.F.A., MR. FUJIOKA? IS IT JAMES AUSTIN BEING INVOLVED IN THAT A.E.C.O.M. JAIL? BECAUSE I THINK THAT'S A REASONABLE QUESTION AND I THINK THE PUBLIC WOULD BE INTERESTED IN KNOWING. I KNOW MAYOR ANTONOVICH TODAY, IT WAS A VERY IMPORTANT DAY FOR THOSE VETERANS AND I SUPPORT EVERYTHING THEY DID THERE, I WANT TO POINT OUT MY APPRECIATION AND ALSO MY APPRECIATION FOR THE A.C.L.U. FOUNDATION WHO I KNOW HE IS STANDING TALL NEXT TO NOW ON THIS ISSUE. AND I JUST WANT TO MAKE ONE SMALL LITTLE REFERENCE. IT'S THE A.C.L.U. FOUNDATION WHO ARE ALSO UNFORTUNATELY, COMING AFTER THE BOARD OF SUPERVISORS TO PUT SOME OF THESE LEGAL BILLS ON THE TABLE SO THAT WE CAN GET TO THE BOTTOM OF THOSE ISSUES THAT DROOYAN HAS BEEN PROMINENTLY SITTING ON TOP OF FOR A LITTLE WHILE. I WOULD URGE THIS BOARD OF SUPERVISORS TO THINK ABOUT THAT AND THINK ABOUT HOW LONG, HOW MUCH MORE MONEY THEY WANT TO SPEND FIGHTING ON THESE ISSUES, FIGHTING ABOUT WHAT IS, AS ONE OF THOSE GENTLEMEN MENTIONED, "THE RULE OF THE LAW" AND HOW IMPORTANT THAT IS. SO HOPEFULLY TODAY IS THE DAY WHEN THE BITTERNESS THAT WE'VE EXPERIENCED CAN BE PUT ASIDE. AND THIS BOARD CAN GO OFF AND THINK IN THEIR INDIVIDUAL DISTRICT OFFICES ABOUT WHO THEY MIGHT PROPOSE TO BE BLUE RIBBON COMMISSIONERS WHO COULD DO THE JOB THAT'S NECESSARY. AND HERE'S A HINT. FREEDMAN WAS A GOOD IDEA, BUT TO BE HONEST, HE'S A PUBLIC HEALTH MAN FOR A LONG TIME. MAYBE HE COULD COME BACK AND RUN PUBLIC HEALTH, ACTUALLY, COMES TO MIND. BUT THE POINT IS: NOW'S THE TIME TO MAKE THE SHORT LIST. AND THEN WE CAN MOVE FORWARD IMMEDIATELY. THANK YOU. 

SUP. KNABE, CHAIRMAN: BEFORE I CALL UP THE NEXT SPEAKERS. I WILL ADD AN ADJOURNMENT ALL MEMBERS AND WE'LL GET TO THE INFO BUT I JUST SAW THAT GRANT LYNN JOHNSON PASSED AWAY AT THE AGE OF 65. GRANT WAS A FORMER CITY -- WE'LL DO ALL MEMBERS ON THIS. HE WAS A CITY COUNCILMEMBER SACRAMENTO, COUNTY SUPERVISOR AND AT ONE TIME HEADED UP THE DEPARTMENT OF HEALTH SERVICES FOR THE STATE OF CALIFORNIA AND WAS VERY HELPFUL TO US ON MANY OF OUR ISSUES THAT CONFRONTED US. I'M NOT SURE THE TERMS AND CONDITIONS BUT HE HAS PASSED AWAY SO I WOULD ASK THAT ALL MEMBERS, THAT WE ADJOURN IN HIS MEMORY. THANK YOU. 

SUP. YAROSLAVSKY: MR. CHAIRMAN, HE WAS NOT ONLY ALL THOSE THINGS, HE WAS ALSO THE REGION 9 ADMINISTRATOR DURING OUR WAIVER DISCUSSIONS DURING THE CLINTON ADMINISTRATION AND HE WAS PIVOTAL IN HELPING US. 

SUP. KNABE, CHAIRMAN: THAT HELPED HIM BECOME DIRECTOR OF HEALTH SERVICES FOR THE STATE. HE WAS AWARE OF OUR ISSUES. GOOD GUY. 

SUP. YAROSLAVSKY: VERY GOOD GUY. 

SUP. KNABE, CHAIRMAN: ARNOLD SACHS AND THEN OUR BENEDICTION FROM MR. SERRANO. 

ARNOLD SACHS: YES, THANK YOU. 

ARNOLD SACHS: GOOD AFTERNOON. ARNOLD SACHS. PUBLIC COMMENT: AND IT'S UNFORTUNATE THAT YOU DID TAKE ITEM 6 OFF THE AGENDA. FASCINATING MORE RULES THAT THE BOARD WANTS TO CHANGE, THIS IS AN ITEM AND YOU WONDER WHY ABOUT BEING POLITE. YOU'RE ELECTED OFFICIALS, YOU KNOW THE POLITENESS GETS TO YOU, YOU CAN ALWAYS LEAVE OFFICE. TAKE A HIKE. THIS IS FROM AN ARTICLE FROM 2/12/12 NO THREAT TO FREE SPEECH BY MY GUY JIM NEWTON. UNDER THE COUNTY COUNSEL PROPOSAL THAT YAROSLAVSKY HAS INTRODUCED AND INSTEAD OF HAVING 2 MINUTES TO COMMENT PER AGENDA ITEM. THE SPEAKERS WOULD GET A TERM OF 3 MINUTES FOR ALL AGENDA ITEMS ON THE BOARD OF SUPERVISORS. SO WHEN DID IT CHANGE TO 3 MINUTES? WELL THAT ITEM WAS NEVER CONSIDERED BY SUPERVISOR YAROSLAVSKY. SO THE CRIMINALS WHO ARE ELECTED TO RUN THE OFFICE OF BOARD OF SUPERVISORS JUST CHANGED THE ITEM. BECAUSE IT SAYS RIGHT HERE NOVEMBER 26, 2013 THAT THE PUBLIC WILL HAVE A TOTAL OF THREE MINUTES PER MEETING TO ADDRESS THE BOARD ON ITEMS IN THE EXECUTIVE OFFICE. SO WHEN DID IT GET VOTED ON? WHEN WAS THE LEGISLATIVE ACTION TAKEN? WHEN WAS THE BOARD UPHOLDING THE LAW? OH, YOU KNOW THE LAWS, THOSE FOOLISH THINGS, YOU KNOW LIKE, AND I KNOW, IT'S BEATING A DEAD HORSE, LIKE WHEN YOU WEAR YOUR OTHER HAT AT METRO, FOR THE BLUE LINE CONSTRUCTION AUTHORITY, HOW DID THAT CHANGE? OR WE COULD TALK A FEW THINGS HERE. IF WE NEEDED A CONSTRUCTION AUTHORITY FOR THE GREEN LINE TO GO NORTH FROM THE AVIATION STATION TO CENTURY BOULEVARD. BUT VOILA, THE CRENSHAW LINE THAT GOES SOUTH FROM CENTURY STATION TO AVIATION, NO CONSTRUCTION AUTHORITY. THE DOWNTOWN CONNECTOR THAT METRO IS TRUMPETING WOULD HAVE BEEN THE BLUE LINE 20 YEARS AGO. MEASURE R, THAT SALES TAX, $1.3 BILLION. AND YOU WANT TO TALK ABOUT ANOTHER SALES TAX. SO AGAIN DO WE HEAR IT WILL BE ANOTHER BILLION DOLLARS, BILLION PLUS? THAT WILL BE $5 BILLION IN TRANSIT TAXES FOR THE METRO. AND WHAT HAVE YOU DONE? ZERO. YOU KNOW, MY FARE'S GOING UP $40 NEXT MONTH AND THAT'S THE KIND OF LEADERSHIP I GET FROM MY ELECTED OFFICIALS. IT'S REALLY, I KNOW IT'S TOO MUCH. YOU SHOULD BE KINDER, GENTLER. YOU KNOW, I HAVE GOOD NEWS FOR YOU, THOUGH. SARAH PALIN, DO YOU REMEMBER WHEN SHE MADE THAT REMARK? SHE WASN'T REFERRING TO THE BOARD. I CAN TELL YOU HONESTLY, SHE REALLY WASN'T. DO YOU KNOW WHY? NOT ENOUGH LIPSTICK. MR. SERRANO? 

DAVID SERRANO: GOD IS THE FATHER AND THE SON AND THE HOLY SPIRIT. THE HOLY TRINITY IS THE ONE AND ONLY GOD, AMEN. HALLELUJAH. THE HOLY TRINITY IS THE CREATOR OF HEAVEN AND THE UNIVERSE, AMEN, PRAISE THE LORD, HALLELUJAH. REALITY IS THAT INFINITE GOD ALMIGHTY JESUS CHRIST CREATED HEAVEN AND THE UNIVERSE, AMEN, PRAISE THE LORD. ACCORDING TO THE HOLY WILL OF GOD, THE LORD GOD JESUS CHRIST COMMANDED THE UNIVERSE INTO EXISTENCE BY THE SPOKEN WORD OF GOD. AND JESUS CREATED THE UNIVERSE BY WAY OF THE BIG BANG THAT INCLUDES INFLATION. AND THAT THE VERY EARLIEST BEGINNING OF THE UNIVERSE, THE OBSERVABLE UNIVERSE WAS ACTUALLY SMALLER IN SIZE THAN AN ELECTRON ORBITING THE NUCLEUS OF AN ATOM, AMEN, HALLELUJAH. HALLELUJAH, AMEN, PRAISE THE LORD, GOD IS GOOD. JESUS CHRIST IS GOD. AMEN. THE HOLY TRINITY IS THE ONE AND ONLY GOD. AMEN, PRAISE THE LORD. ETERNAL JESUS WAS CONCEIVED BY THE POWER OF THE HOLY SPIRIT OF GOD. AND CHRIST WAS BORN OF THE SANCTIFIED VIRGIN MARY. THE SON OF GOD NEVER SINNED. JESUS CHRIST THE PREACHED THE WORD OF GOD AND HE FORGAVE PEOPLE'S SINS. THE LORD JESUS CURED LEPROSY. CHRIST GAVE SIGHT TO THE BLIND. JESUS MULTIPLIED A FEW PIECES OF BREAD AND FISH MIRACULOUSLY AND HE FED THOUSANDS OF HUNGRY PEOPLE. THE ETERNAL SON OF GOD REALLY RAISED DEAD PEOPLE TO LIFE. INNOCENT JESUS DIED FOR OUR SINS ON THE CROSS AS OUR SUBSTITUTE. HE WAS BURIED AND THEN ON THE THIRD DAY, JESUS CHRIST RESURRECTED AND HE LEFT THE TOMB, AMEN. JESUS CHRIST APPEARED TO HUNDREDS OF HIS DISCIPLES OVER THE COURSE OF 40 DAYS. JESUS CHRIST ASCENDED INTO HEAVEN. THE LORD JESUS CHRIST IS AT THE AT THE RIGHT HAND OF INFINITE GOD THE FATHER ALMIGHTY IN THE KINGDOM OF THE MOST HIGH. PRAISE THE LORD. WE ARE SAVED BY THE GRACE OF GOD THROUGH FAITH IN JESUS. CHRISTIAN SOULS AND SPIRITS ASCEND INTO THE KINGDOM OF HEAVEN, AMEN. CHRISTIANS RECEIVE LIFE EVERLASTING WITH GOD IN THE KINGDOM OF GOD, PRAISE THE LORD. GOD BLESS THE UNITED STATES OF AMERICA, AMEN, PRAISE THE LORD. CHRISTIANS HAVE LIFE EVER LASTING WITH GOD IN THE KINGDOM OF GOD, AMEN. UNBELIEVERS DIE AND RECEIVE THE PENALTY FOR THEIR OWN SINS. UNBELIEVERS DIE AND BURN IN SHEOLE HADES. REPENT AND BELIEVE REALITY. JESUS IS GOD. AND THEN YOU WILL HAVE LIFE EVER LASTING WITH GOD IN THE KINGDOM OF GOD AMEN, PRAISE THE LORD. GOD BLESS THE UNITED STATES OF AMERICA! AMEN. 

LORAYNE LINGAT: IN ACCORDANCE -- 

SUP. KNABE, CHAIRMAN: BEFORE WE GO INTO CLOSED SESSION, I HAVE SOMETHING THAT HAS BEEN BROUGHT TO MY ATTENTION THIS MORNING, I NEED AN URGENCY. IT'S ON A REWARD REQUEST BY ONE OF OUR LOCAL LAW ENFORCEMENT AGENCIES. ON THURSDAY, JULY 25TH, 2014, JUST BEFORE 11 O'CLOCK LONG BEACH POLICE OFFICERS RESPONDED TO A SHOOTING IN LONG BEACH. WHEN OFFICERS ARRIVED, THEY DISCOVERED 29-YEAR-OLD OLATAGA FILOMONI ON THE GROUND SUFFERING FROM SEVERAL GUNSHOT WOUNDS. THEY TRANSPORTED HIM TO A LOCAL HOSPITAL WHERE HE UNDERWENT EMERGENCY SERVICES. HE SUCCUMBED TO HIS INJURIES AND DIED AT THE HOSPITAL A FEW DAYS AGO. INVESTIGATORS LEARNED THAT OLATAGA, A LONG BEACH RESIDENT WAS TALKING WITH A FRIEND AND RELATIVE IN FRONT OF HIS RESIDENCE WHEN A CAR THEY DID NOT RECOGNIZE STOPPED IN FRONT OF THE HOUSE. AND SOMEONE INSIDE THAT CAR YELLED A GANG PHRASE AND SINCE NO ONE IN OLATAGA'S GROUP WAS A GANG, THEY INITIALLY DID NOT REACT TO THE STATEMENT. ALMOST SIMULTANEOUSLY GUNSHOTS WERE FIRED. AND INTO THE VICTIM'S DIRECTION, GROUP. ONLY ONE PERSON WITH HIM WAS ABLE TO PROVIDE A DESCRIPTION, A SMALL COMPACT. SEVERAL OTHER WITNESSES REPORTED HEARING THE SHOTS. SO INVESTIGATORS HAVE CANVASSED THE NEIGHBORHOOD LOOKING FOR WITNESSES AND FEEL THAT IT WOULD BE IMPORTANT TO OFFER A REWARD AT THIS POINT WHICH MAY PROMPT SOME RELUCTANT WITNESSES TO COME FORWARD. I WOULD MOVE THAT THE BOARD OFFER A $10,000 REWARD FOR INFORMATION LEADING TO THE ARREST AND CONVICTION OF THE PERPETRATORS OF THIS HEINOUS CRIME. WITHOUT OBJECTION, SO ORDERED. 

LORAYNE LINGAT: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM CS-1 CONFERENCE WITH LEGAL COUNSEL REGARDING EXISTING LITIGATION, ITEM NO. CS-2, DEPARTMENT HEAD PERFORMANCE EVALUATIONS AND ITEM NO. CS-3, CONFERENCE WITH LABOR NEGOTIATORS WILLIAM T FUJIOKA AND DESIGNATED STAFF AS INDICATED ON THE POSTED AGENDA. THANK YOU. 
REPORT OF ACTION TAKEN IN CLOSED SESSION AUGUST 19, 2014

CS-1. CONFERENCE WITH LEGAL COUNSEL  EXISTING LITIGATION (Paragraph (1) of subdivision (d) of Government Code Section 54956.9) Samuel Dacus v. County of Los Angeles, Superior Court Case No. BC497383 This is an employment discrimination lawsuit involving the Sheriff s Department. (14-3696) 
The Board authorized settlement of the matter entitled Samuel Dacus v. County of Los Angeles. The details of the settlement will be made available once finalized by all parties. 
The vote of the Board was 3-1, with Supervisors Ridley-Thomas, Yaroslavsky and Knabe voting aye; Supervisor Antonovich abstaining; and Supervisor Molina being absent. 
No reportable action was taken on items CS-2 or CS-3. 
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     I further certify that I am neither counsel for, nor related to any party to the said action; nor

in anywise interested in the outcome thereof.
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